License Agreement

THANK YOU FOR PURCHASING THIS PRODUCT. ITIS
IMPORTANT THAT YOU CAREFULLY READ THIS NOTICE
BEFORE OPENING THIS PACKAGE. BY OPENING THIS
SEALED PACKAGE, YOU AGREE TO THE TERMS AND
CONDITIONS OF THIS AGREEMENT AND CREATE A
BINDING CONTRACT BETWEEN YOU AND RELIABLE
POWER METERS ("RPM").

This Agreement may be terminated and you may be required to
delete from your computer or server and/or return the Software in
the event you fail to observe the terms of this Agreement.

License. RPM grants to you a nonexclusive, nontransferable
license to use one copy of the enclosed software program (the
"Software") and accompanying documentation in accordance with
the following terms and conditions.

You may:
a.  Use the Software under the following procedure specified for

the version you licensed, as specified on (1) the packaging of the
Software, (2) your Order Form, Lease and License Agreement or
other signed agreement with RPM, or (3) your separate written
agreement or receipt or invoice with the vendor of the Software
(the "Governing Terms"):

(1) (if specified as a "stand alone" version) install the Software
on a stand-alone computer or a network node from which
node the Software cannot be accessed by another computer or
user; or

(i) (if specified as a "single user" version) install the Software on
one or more stand-alone computer(s) or network node(s),
provided that such Software shall be used by only one
individual within your organization; or

(iii) (if specified as a "LAN" version) install the Software on a
network server at one site only, which server provides access
to multiple computers or users, up to the maximum number
of computers or users specified in such Governing Terms;

b. Make one (1) copy of the Software solely for back-up
purposes, reproducing in or on such copy all proprietary notices in
or on the Software; and

c.  Physically transfer the Software from (as applicable):

(1) one stand-alone computer or node to another stand-alone
computer or node; or

(ii) one server to another server,

provided that the Software is used on only one computer, node or
server at a time.

You may not:
a. Modify, translate, reverse engineer, decompile, disassemble,

create derivative works based on, or copy (except for the back-up
copy) the Software or the accompanying documentation, except
and only to the extent permitted by applicable law;

b. Transfer, loan, rent, lease, distribute or grant any rights in the
Software or accompanying documentation in any form without the
prior written consent of RPM;

c. Remove any proprietary notices, labels or marks on the
Software and accompanying documentation.

This license is not a sale. Title and copyrights to the Software,
accompanying documentation and any copy made by you remain
with RPM or its licensors, as the case may be.

Confidentiality. The Software contains confidential trade secret
information belonging to RPM, and you may use the Software
only pursuant to the license set forth herein. In addition, you may
not disclose the Software to any third party.
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Limited Liability. IN NO EVENT WILL RPM'S LIABILITY
UNDER, ARISING OUT OF OR RELATING TO THIS
AGREEMENT EXCEED THE AMOUNT PAID TO RPM FOR
THE SOFTWARE. RPM SHALL NOT BE LIABLE FOR ANY
SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL
DAMAGES, HOWEVER CAUSED AND ON ANY THEORY
OF LIABILITY. WITHOUT LIMITING THE FOREGOING,
RPM WILL NOT BE LIABLE FOR LOST PROFITS, LOSS OF
DATA, OR COSTS OF COVER.

Limited Warranty. RPM warrants that:
(1) for a period of ninety (90) days from the date of delivery to
you, as evidenced by a copy of your receipt; or

(i) (for a rental license, if so specified in your Governing Terms)
for the period of your rental, as specified in your Governing
Terms,

the media on which the Software is contained and the
documentation accompanying the Software will, under normal
use, be free from defects in materials and workmanship. EXCEPT
FOR THE FOREGOING, RPM MAKES AND YOU RECEIVE
NO WARRANTIES OR CONDITIONS, EXPRESS, IMPLIED,
STATUTORY OR OTHERWISE, AND RPM SPECIFICALLY
DISCLAIMS ANY IMPLIED WARRANTY OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. RPM's entire liability and your exclusive remedy
under this warranty will be for RPM to, at its option, arrange for
replacement of the media or refund your purchase price and
terminate this Agreement.

Exceptions. SOME STATES DO NOT ALLOW THE
LIMITATION OF INCIDENTAL DAMAGES OR
LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY
LASTS, SO THE ABOVE LIMITATIONS OR EXCLUSIONS
MAY NOT APPLY TO YOU. This agreement gives you specific
legal rights, and you may also have other rights which vary from
state to state.

U.S. Government Restricted Rights. Use, duplication or
disclosure of the Software and accompanying documentation by
the U.S. Government is subject to restrictions as set forth in
subparagraph (c)(1)(ii) of the Rights in Technical Data and
Computer Software clause at DFAR 252.227-7013, Rights and
Technical Data in Computer Software (June 1992), in subpara-
graphs (c)(1) and (2) of FAR 52.227-19 Commercial Computer
Software - Restricted Rights (June 1992), or FAR 52.227-14,
Rights in General Data Alternative III (June 1992), as applicable.
Contractor/Manufacturer is Reliable Power Meters, Inc., 400
Blossom Hill Road, Los Gatos, CA 95032.

General. You will not export or reexport the Software in any form
without the appropriate United States and foreign government
licenses. The disclaimers, exclusions and limitations contained in
this Agreement shall inure to the benefit of RPM's licensors. This
Agreement will be governed by the laws of the State of California,
without reference to conflict of laws principles or the provisions
of the U.N. Convention on the International Sale of Goods. This
Agreement is the entire agreement between us and supersedes any
prior communications or advertising with respect to the Software
and accompanying documentation. In the event any provision of
this Agreement is held to be unenforceable, such unenforceability
shall not affect the other provisions of this Agreement, which
provisions shall remain in full force and effect. This Agreement is
not assignable by you.
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FCC NOTICE

INFORMATION
FOR THE
USER

This equipment has been tested and found to comply with the limits for a
Class A digital device, pursuant to Part 15 of the FCC Rules. These limits
are designed to provide reasonable protection against harmful
interference when the equipment is operated in a commercial
environment. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the
instruction manual, may cause harmful interference to radio
communications. Operation of this equipment in a residential area is
likely to cause harmful interference in which case the user will be
requited to correct the interference at his/her own expense.

The user may find the following publication prepared by the Federal
Communications Commission helpful:

“How to Identify and Resolve Radio-TM Interference Problems” (Stock
Number 004-000-00345-4).

Available exclusively from the Superintendent of Documents,
Government Printing Office, Washington, DC 20402 (telephone 202-
512-1800).

FCC
WARNING

Changes or modifications not expressly approved by the party
responsible for compliance to Part 15 of the FC Rules could void the
user’s authority to operate the equipment.

INDUSTRY
CANADA

ICAN CLASS
A DIGITAL
EQUIPMENT

This digital apparatus does not exceed the Class A limits for radio noise
emissions from digital apparatus as set out in the interference-causing
equipment standard entitled “Digital Apparatus,” ICES-003 of the
Industry Canada.

Cet appareil numerique respecte les limites de bruits radioelectriques
applicables aux appareils numeriques de Classe A prescrites dans la
norme sur le materiel brouilleur : “Appareils Numeriques,” NMB-003
edictee par le minstre des Communications du Canada.




WARNING

The Power Recorder System is for use by qualified personnel only. Do
not install the Power Recorder on a power line unless you are
qualified to do so. High voltages that can cause burns and lethal shocks
are present during power monitoring.

To assure operator safety: When making connections to power lines,
always start by connecting the instrument power, which contains the
safety earth ground, to a 3-prong grounded outlet.

Use standard high-voltage, high-current safety precautions.

Workers who open energized power panels are required to abide by the
instructions of ANSI/NFPA 70E-1988 [B2] concerning approptiate
protective equipment, as well as government regulations codified in
ASHA CFR 1910 [B3] and 1926 [B4], and in ANSI C2-1990 [B1].

WARNING

In order to comply with FCC requirements, a single shielded and
grounded power cord must be used to connect AC power to the unit.
This is the type of power cord RPM supplies with the instrument.

CAUTION

Connections between peripherals of the computer equipment must be
made with low voltage shielded computer data cables and compatible
components must be used.




Trademark Information

Power Analysis System and Power Recorder are trademarks of Reliable
Power Meters.

Microsoft is a registered trademark of Microsoft Corporation.

Windows is a trademark of Microsoft Corporation.

Technical Support

Reliable Power Meters is ready to assist you. For technical support or sales,
contact Reliable Power Meters at:

Address: 400 Blossom Hill Road

Los Gatos, CA 95032-4511
Voice: 408-358-5100, M-F, 8 to 5 (PST).
Fax: 408-358-4420
E-mail support@ReliableMeters.com
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About this Guide

This guide introduces the features of the Power Recorder System Software. It
also provides detailed information about installing the Power Recorder at a
facility, connecting it to power, and configuring it through a PC running the
Power Recorder System Software.

When you’re ready for detailed information about the software
interface, commands, and features of the Power Recorder System, use
the Power Recorder System Help facility. In the Power Recorder System
software, press F1 or use the Help menu. If you need more information
about using the Power Recorder System Help facility, see page 15 of this
guide.

Conventions

The screenshots in this guide show three-phase wye power. The Power
Recorder System Software also measures single-phase power, split single-
phase power, three-phase delta, and two and one half element. The screens
you see on your PC will reflect the type of power you measure.

The screenshots were taken under Windows 95. If you use another version
of Windows, your screens may look slightly different.

Throughout this guide, instructions for using the Power Recorder System
Software tell you how to perform actions using the pointer and a mouse or a
trackball and buttons. In many cases, you can also use the keyboard.

For example, when a menu or command name shows an underlined letter,
such as File, you can choose the command by holding down the Alt key and
typing the letter, like this: Alt+F .




Before You Begin

This guide assumes that you have some experience working with personal
computers and the Microsoft® Windows™ interface. In particular, you
should know how to:

Choose commands from menus
Double-click to start an application

Minimize a window to an icon, restore the icon to its window, and
maximize a window to fill the screen

Move, resize, and close windows

Press-and-drag to move objects

If you’re new to Microsoft Windows, you can pick up these skills quickly and
easily. See the Microsoft Windows manual that came with your PC. There are
also some excellent training books and courses that can help you learn to use
Microsoft Windows. Many are given at local PC distributors, community
colleges, and high schools.




Introducing the Power Recorder
System

The Power Recorder System combines a sophisticated power-monitoring
unit (the Power Recorder) with a separate controller (a PC running the
Power Recorder System Software) on which you can view and analyze the
power at a facility.

The Power Recorder System is an extremely versatile tool that combines the
functions of a variety of measuring instruments and adds unique new
features which were previously unavailable in the industry. A number of
upgradeable measurement options are available. Each Power Recorder can
be customized to meet your needs. You can install the measurement options
you need now and easily add other options through software upgrades as you
need them in the future.

The Power Recorder System Software runs on a PC under Microsoft®
Windows™. Color graphs and a graphical user interface make it easy to
inspect data and quickly find the information you need.

You can perform immediate, real-time inspections

The Power Recorder System Software’s oscilloscope tools let you inspect
real-time power conditions and dynamically monitor the distribution system.
It is important to verify the integrity of the steady state conditions before
monitoring for transitory events.

When you want to inspect real-time conditions, you:
1. Install the Power Recorder at a facility.

2. Connect and link the PC to the Power Recorder. (There is no need to
preset thresholds.)

3. Define the voltage and type of power being inspected.

4. Use the Scope tools in the Power Recorder System Software to inspect
real-time waveforms, harmonics, impedances, and power parameters.

A snapshot of the oscilloscope waveforms is stored in both the Power
Recorder and in the database on your PC, so you have a permanent record of
the initial conditions and can view them later on the PC when it’s no longer
connected to the Power Recorder.
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For more information about inspecting real-time conditions, see “Using the
Scope Tools to Inspect Real-Time Power” on page 78.

You can analyze long-term power quality and flow

The Power Recorder contains 4MB of RAM and a hard drive large enough
to easily store data collected over days, weeks, or months without worrying
about changing paper or running out of recording media such as floppy disks
or memory cards.

When you want to inspect monitored data:

1. Install the Power Recorder and leave it at a facility to record data over a
period of time.

2. After data has been collected, connect and link the PC to the Power
Recorder and download the data you want to analyze.

Downloading is fast and easy. You can choose to retrieve events, event
summaries, one or more long-range summaries, or all the data.

If you’re working with an individual Power Recorder, you can download
data from it on-site, or you can take the Power Recorder back to your
office before connecting it to a PC. If you have installed a network of
Power Recorders, you can download over the network. You can even set
up a dial-in connection to retrieve data over phone or ISDN lines, or
over the Internet.

3. After you’ve downloaded the data, analyze it at your convenience. With
the analysis tools in the Power Recorder System Software, you can
display long-term power conditions such as power consumption and
harmonic trends as well as capture transitory events and analyze
disturbances.

For more information about inspecting monitored data, see “Using the
Analysis Tools” on page 82.

The Power Recorder System’s modular design gives you
flexibility

Because the Power Recorder is independent of a PC and easily portable, you
can make the best use of your equipment. Sometimes you’ll want both a
recorder and a PC at a facility to inspect power measurements prior to
monitoring. Other times you may want to install a Power Recorder to collect
data for a period of time, in which case you need the PC only to configure
the recorder and to download data when you’re finished monitoring. And in
other cases you’ll set up a network of Power Recorders that remain installed
for continual monitoring.
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Here are some of the ways you can work:

Install a Power Recorder at a facility and connect it to a PC running the
Power Recorder System Software to inspect real-time power conditions
or check for wiring problems. You can examine the initial conditions
before determining whether to monitor. If you decide to monitor, you
can leave the Power Recorder installed and take the PC with you.

Install a Power Recorder when you know at the start that you want to
analyze the power over a period of days, weeks, or more. Then connect a
PC to it when you’re ready to download the data.

Install a temporary network of Power Recorders to monitor power
simultaneously throughout a facility. With a PC running the Power
Recorder System Software as an integral part of the network, you can link
to each of the recorders over the network.

Use a PC with 2 modem as a communication controller for one or more
Power Recorders. You dial in and link from an off-site PC running the
Power Recorder System Software.

Set up a PC as a polling station and automate the process of connecting
and downloading data from one or several Power Recorders. Using the
Polling/ Annunciation upgrade to the Power Recorder System Software,
you can also set alarms to alert you when out-of-tolerance events occur
or when a recorder is no longer online. (For complete details, see the
Polling/ Annunciation Software Guide.)

For more information about individual and network connections to power
recorders, see page 27.

Built-in safety features minimize monitoring hazards

Inspecting and monitoring power can be a hazardous process. The Power
Recorder System is designed to reduce the hazards involved to a minimum.

A number of interchangeable voltage probes and current clamps are
available to provide safe, secure connections to a variety of contact
points.

The standard Power Recorder has built-in LEDs that give you immediate
teedback when the instrument is receiving valid voltage and current
signals. If you’re using the Power Recorder model with the Hostile
Environment Enclosure, these built-in LEDs are provided on the
Current Interface Cable and the Voltage Interface Cable.

Phase rotation and clamp polarity errors can be corrected through the
Power Recorder System Software.

As opposed to older instruments that required multiple wires for analog
subtraction and addition, the Power Recorder uses digital addition and
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subtraction, thus increasing safe use of the instrument by reducing the
number of connections that have to be made.

What'’s Included in the Power Recorder System

A complete Power Recorder System includes the following:

A Power Recorder

A PC running the Power Recorder System Software

A number of different Power Recorder models are available to meet different
needs. You can select models that have:

A standard case or a Hostile Environment Enclosure
A parallel port or an Ethernet port

A range of measurement options (for details about specific models and
measurement options, see the Reliable Power Meters Price List and
brochure or contact your local representative)

All Power Recorder models includes the following:

The Power Recorder with either Ethernet or parallel communications
port

Power Recorder power cable

PC-to-recorder cable (Ethernet or parallel, depending on the
communication port of the Power Recorder)

For Ethernet units, a RPM-to-RJ45 cable and an RJ45 female-to-female
interconnect with a short swap RJ45-to-RJ45 male cable

Five Crocodile-type voltage probes (# 3601)

For units with the Hostile Environment Enclosure, Voltage and Current
Interface Cables

For standard units, 10-foot long Voltage Interface Cables for connection

NOTE

Current clamps are not included as part of the standard package, but are
available through Reliable Power Meters.

For further details about the models and for a list of optional accessories, see
the Reliable Power Meters Price List.
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Two optional software enhancements are available for the Power Recorder
System Software:

m  Polling/ Annunciation Software
m  Professional Report Writer Software

For more information, see the Reliable Power Meters Price List or contact
your RPM Representative.

PC System Requirements

You may purchase a PC from Reliable Power Meters or you may provide
your own.

The minimum recommended PC platform includes:
®  Pentium-class processor

= (64 MB RAM

® 5 GB hard disk

m  Microsoft Windows (current supported version)

®m  10Base-T Ethernet adapter (for use with the Ethernet series of Power
Recorders)

m  SVGA Color display

Reliable Power Meters assumes no responsibility for configuring or

NOTE  assuring the proper functioning of computers or PC Ethernet adapters.
Reliable Power Meters recommends that users have their Ethernet PC
card configured by their MIS department or local PC supplier.

Registering the Power Recorder System Software

Be sure to return the enclosed registration card to Reliable Power Meters.
This tells us where to send information about software updates and lets us
keep you up to date on enhancements to the Power Recorder System
Software through technical bulletins.
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Installing the Power Recorder System
Software

You can install the Power Recorder System Software on any personal
computer that meets the requirements listed on page 5.

NOTE

If you are upgrading to a new version of the Power Recorder System
Software, follow the instructions in Appendix C.

To install the Power Recorder System Software

1. Start your personal computer and Microsoft Windows.
2. Insert the first installation disk in your diskette drive (usually A or B).
3. From the Program Manager, open the File menu and choose Run.
4. In the dialog box that appears, type:
= ANSETUP or BI\SETUP

1.  Be sure to use the correct designator for the floppy drive in
which you inserted the installation disk.

5. Click OK.

6. Follow the instructions that appear on the screen, and swap diskettes
when requested.

The Power Recorder System Software is installed on the hard drive of your
computer and a program group named “RPM” is created.







Power Recorder System Software
Basics

This section of the Power Recorder System User Guide tells you how to start the
Power Recorder System Software and introduces you to the main elements
and tools you’ll use on the screen. It also includes instructions for opening
database files and creating sites and locations in the Database Site Directory.

For an introduction to the main functions in the Power Recorder System
Software—the Scope and Analysis tools, see “Using the Power Recorder
System Software Tools: An Overview” on page 77.

Starting the Power Recorder System Software

Note: You need about 50 MB of disk space free on your hard drive in order
to run the software.

To start the Power Recorder System Software
1. Turn on your computer and start Microsoft Windows.

2. When the Microsoft Windows desktop appears,
locate the Power Recorder System Software icon,

point to it, and double-click. Power Analyzis
Software

Or click the Start menu, choose Programs, choose the folder in which
you installed the software (typically Reliable Power Meters), and then
select the Power Analysis Software icon.

The main window opens and displays a new, untitled database, or the last
database used on this computer, depending on the setting in Preferences.
The initial setting is to open a new database.
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The Power Recorder System Window and Toolbar

The name of any open database and site ~ These buttons represent the
appear in the title bar. software’s main tools.

[ (O] =]
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Buttons in this == it R
toolbar represent
frequently used
commands.

Each button in the toolbar represents one or more tasks you can perform.
Most are also available as commands on one of the menus. !

LOCT“OH List Link/ Unlink Download Sweep Scope Polling
= |Ser-.-iceF’aneI ;I m

Site Directory Copy Graphics Monitor Capture Help Analysis Report Writer

To choose a command from the toolbar

v Move the pointer to the tool you want to use and click.

Some tools open dialog boxes, such as Open and Site Directory. Others
display icons and diagrams for your use, such as Scope, Monitor, and
Analysis. Moreover, some perform a command immediately, such as
Copy, Sweep, and Help.

! Polling features are available only if you purchased and installed the Polling/Annunciation Software package.
Report Writer features are available only if you purchased the Professional Report Writer Software package.
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Opening the Sample Database

The Power Recorder System Software comes with a sample database. You
can use it to see how the software works if you don’t yet have a database that
contains data you’ve monitored.

To open the sample database

1. Click the Open button in the toolbar. E

2. Select the database SAMPLE.OMGrom the list.
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3. Click OK.
The sample database opens.

For complete information about working with databases, see page 17.

1
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Using Icons and Windows

Icons show real
data in the Scope,
Analysis, and
Polling Views and
can be opened to
larger windows.

The Scope, Analysis, and Polling tools are actually collections of tools. When
you click the buttons for these tools and Analysis, a series of additional tool
buttons appear at the right, and small windows (called icons) appear in the
window.

The icons are actually small-scale windows that present data about the power
at a location. Each icon can be opened to a larger window by double-clicking
it.

...additional tools

When you choose appear here. This
the Scope, Analysis, picture shows the

or Polling tool... Scope tools.
.III'H Powes Nacoidsl Sl - dphic Soienes leaiemsssic [These phaee weew]
Fle ES Beoosdu Furonon Dplop Help
=T B [ B o B [l B b I W e

NOTE

To view information with the Power Recorder System Scope and Analysis
tools, you must either be hooked up to an installed Power Recorder, or
have previously monitored power conditions and downloaded them to a
database on the computer.

If you don’t have your own data yet, you can use the demo database
SAMPLE.OMGo see how these tools work. For details, see page 11.
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To open

an icon to a window

v Point to the icon and double-click to open it.

The icon opens to a window.
T e -
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To close a window
v Double-click one of the Close boxes in the upper corners.
Close box — Close Box
Lpl ] SCEETC G W el § O e ﬁ
H‘“‘ Faain & Vallege Preian, A 12 FFRIRIZ T
i — ==
Hoyras AT A N &
] & ;5 LY i | |5 H
i N/ N N u When a window
Cless Tl __has additional
N P Py i M tools available,
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they appear here.
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To open another window

You can have a number of windows for the same tool open at the same time.

1. Point to the top edge of the first window and press and drag the window
to a new location.

2. Double-click another icon to open its window.

To see more detail about the contents of a window

In many windows, you can see additional detail by magnifying some of the

data in a window.

1. Select the data you want to see in more detail.

Tae 3ime

Frey 1100

e

rPeerry Fagd MaLY
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Fraaws & Yolsge =iz dor 121335 1EIZ2 30

Point to the beginning >
of the area you want

™ ['r., __.-'

to measure or wy
magnify. o
s
//
Then press and drag_—" )
diagonally across i,
the area you want. A L

selection rectangle
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e
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appears. r—__
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| The status bar
shows data
about the

L Magnify tool

2. Click the Magnify tool to magnify the detail you

selected.

indicate this window shows magnified information.

3. When you’re finished, click the Magnity tool to

return to the original view of the window.

The contents of the window are replaced by a magnified view of the
selection. The Magnify tool changes shape from a plus to a minus to
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Getting Help

While you’re working in the Power Recorder System Software, you can get
help at any time. You can see a brief description of each of the commands
and buttons, ask for help about what’s on the screen, or look up a topic you
want to find more information on.

Note: The Power Recorder System Help contains more complete
information than you’ll find in this manual. If you are looking for
information and you don’t find it in the User’s Guide, be sure to check the
Help while you're using the softwatre. You’ll find detailed discussions about
the contents of each Scope and Analysis window and each dialog box in the
Power Recorder System Software.

To see a definition of a command or button
1. Click the Help button or press Shift + F1.

The pointer changes to the help pointer shape. Re

2. Point to the button or command you want to know about.

As you point to each button and command, a brief definition of it
displays at the bottom of the screen.

3. To open the Help window and see detailed information about a button
or command, click on the button or command with the help pointer.

The Help window opens.

To get help about the active view or dialog box
v Press F1 or click the Help button.

The Help window opens and displays information about the contents of
the screen.
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To browse through Help and find a topic

1. Choose Contents from the Help menu, or click the Contents button in
the Help window.

A window listing the contents for the Power Recorder System Help
system appears.

Each underlined item represents another topic.
2. Click the topic you want to view.

You see a list of sub-topics or information about the topic you selected.

To learn more about using on-line Help
v Choose How to Use Help from the Help menu.

The Help window opens and displays information about using Help in
Microsoft Windows.
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Power

Files associated with
the database are
stored in a
subdirectory.

Recorder System Software Databases

The Power Recorder System Software organizes information in a database.
You can have one database, or many. Each database can contain information
about the power at many different locations.

A Power Recorder System database is actually a collection of files, with one
primary file that uses the database’s name. The files associated with each
database are stored together in a subdirectory.

Power Recorder System databases can be quite large. Data for one location
can use as much as 25 MB if the monitoring session is particularly active,
however data about most locations takes around 3 to 4 MB.

When you start the Power Recorder System Software, you can have it open a
new, empty database, or you can have it automatically open the last database
used, depending on the choice you set in Preferences.

As you use the Power Recorder System Software, you’ll work with databases
in a variety of ways. You can create a new database, open an existing one,
save a copy of a database, create a compressed copy, delete a database, and
even repair a database if it should become corrupted. The next few pages
describe how to perform these tasks.

To open a different database

1. Click the Open button in the toolbar or choose —
Open from the File menu.

2. Sclect the database you want from the list.

[T FlEI=RE
Logkje |3 Foees ek =] ®&| =] = mj
|1 Pollrwg Bwwps boan Joe | BawwpbseCioge m Flaoi- 171 Nwg
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You can scroll through the existing files, change directories, or change
drives to locate the database you want.

If you need help moving through directories and subdirectories, see your
Microsoft Windows documentation.

Click OK.

Only one database can be open at a time. If a database is already open, it
is closed before the new one is opened.

To create a new database

v

Choose New from the File menu.
If a database is already open, it closes before the new one is created.

You don’t name the database now—you will be prompted for a name
when you exit the software or close the database.

To have a new database open each time you start the software

1.
2,

Choose Preferences from the Option menu.
In the Preferences dialog box, unmark the Use Last Database box.

When an “X” appears in the box, the last database used opens
automatically when you start the Power Recorder System Software.

Click OK.

To save a copy of a database

You can save a copy of a database and specify a different name.

1.

Choose Save As from the File menu.
The Save As dialog box opens.
Type a name for the new copy of the database.

Change the directory or drive if you want to save the new database in a
different location.

Click OK.

A new copy of the database is saved.
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To make a compressed copy of a database

You can compress a copy of the files in a database to make a version that
takes 70% less space on disk (approximately a 3:1 ratio). This is useful when
you want to archive the database to a set of floppies, when you want to move
it to another computer, and when you need to free up hard disk space.

Note: You can only compress a closed database. If the database you want to
compress is open now, close it before proceeding.

If you’re archiving to floppies, you should have 3 to 4 high-density floppies
ready before starting. The compression process erases and reformats the
diskettes, so make sure that they do not contain data you want to keep.

1.

Choose Compress from the File menu.
The Compress Database dialog box opens.

Select the database you want to compress from the list. The database is
named with the extension .OMG

You can change the directory or drive, if necessary, to find the primary
database file.

Click OK.

The Compress Database dialog box is replaced by the Destination Zip
file dialog box.

Type the name you want the compressed copy of the file to have.

If you don’t change the name, the name of the original database is used
with the extension ZIP.

Change the directory or drive if you want to save the compressed version
of the file in a different location.

You see the status of the compression as the new file is created.

If you want to free up disk space, you can delete the uncompressed
database from your computer’s hard drive.

Be sure to use the Delete command in the Power Recorder System
Software to delete the database. For details, see page 21.
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To expand a database

You can expand the files in a database that has been compressed.

1.

Choose Expand from the File menu.
The Expand Database dialog box opens.

Select the database you want to expand from the list. The database is
named with the extension .ZIP .

You can change the directory or drive, if necessary, to find the
compressed file.

Click OK.

The Expand Database dialog box is replaced by the Destination
Database dialog box.

Type the name you want the expanded database to have.

If you don’t change the name, the name of the compressed database is
used, with the extension OMG.

Change the directory or drive if you want the expanded version of the
database to be stored in a different location.

The status of the expansion displays as the new files are created.

To conserve disk space, you may want to delete the compressed version
of the file (with the extension .zip).

To repair a database

You can repair the files in a database if they get corrupted. (Files may be
corrupted if a system crash occurs on the PC while it is running and
communicating with a Power Recorder.)

1.

Choose Repair from the File menu.

If Repair is dimmed on the File menu, choose Close and close the
database that’s now open. Then try again.

The Repair Database dialog box opens.

2. Select the database you want to repair from the list on the left. The
database is named with the extension .OMG
You can change the directory or drive, if necessary, to find the primary
database file.

3. Click OK.
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You see the status of the repair as errors are fixed in the database. When
the repair is finished, a message tells you how many records were
examined, and how many repaired. (Minor repairs may be made without
being counted as repairs.)

Click Done.

In the Site Directory, select the site and location for which you want to
view data and click OK.

To delete a database

If you want to delete a database from your computer, be sure to use the
Delete command on the File menu while you are using the Power Recorder
System Software. Do not delete files through File Manager or DOS.
When you use the Delete command from within the Power Recorder System
Software, all the files associated with the database are deleted at once.

You can only delete a database that is not presently open.

1.

Choose Delete from the File menu.
The Delete dialog box opens.

In the File Name list, select the primary file (XXX.0mg ) for the database
you want to delete.

Click OK.

When you’re asked to confirm that you want to delete the database, click
Yes to delete it.

All files associated with the database are deleted.
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Setting Up a New Site in the Database

If you’re measuring power at a new facility or a new building, start by
creating a new site in the database.

A site represents a distribution system, or a portion of one, in a database.
You can set up many different sites in the same database. And for each site,
you can set up multiple locations where you plan to measure data. A
location represents the actual panel or branch load where you physically
connect the Power Recorder. Each time you link and download data from a
Power Recorder you’re given the chance to save the data as a new location.

Sites provide a way to organize information in the database—they let you
group information about related locations.

Site information also becomes part of the Power Recorder configuration.

To set up a new site

1. If you’re not connected to the Power Recorder, ==
. . . =3n
click the Site button in the toolbar. =

If you are connected to the Power Recorder, open the Link dialog box
(choose either Link or Link Info from the Recorder menu) and click
Edit.

The Site Directory opens.

2. C(lick New in the Site Information area of the Site Directory.

Power Recorder System - Site Directory E3
i — Site Information X
The s&e.s glr;ee:)dy set _ New. | Click New to set up
up In this database sLocal Site> — 1 a new site.
are listed here. | Building 10 Delete |
/ iElectronic Spsterns

Metwork, 36 ;
If you're linked to a RPM Lobby Ll

Substation 2
Ppwer Recordgr, the e No: 100244
site name now in the
angle brackets. Memo: Mo mitigation eauipment

at installation

r Location Infarmation

Mew...
The locations for
the selected site — | Delete |
ok I

are listed here. Edit...

Cloze | Help |
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3. In the Site Information dialog box that appears, enter information about

the site.
Power Recorder System - Site Information E

r Site Information

Site Mame IE lectronic Systens Main Building

' . Account Mumber |‘| 00244,
Enter information

about the site —_

Phone Number ~ [415 7551212

here. Date Created Mo 09 1996 14:58
CantactMame | Staffard 'williams
Mema IND mitigation eqiupment at installation

r— Froblern Infarmation

Brief Problem Description IL,&_N subject to resetting
Enter information Date First Moticed (mm/dd/yy)  [11/03/36
about the problem |
here. Froblem Frequency IMore thar once a day j
How Problam Exhibits |tsel |Unknouwn =l

Problem Cost I
0K I Cancell Help |

The Site Name is required. Account Number, Phone Number, Contact
name, and Memo are optional. Use them to keep track of information
you want to associate with this site.

The date is inserted automatically to record when the site was created.

Press Tab to move from one field to the next; Shift-T'ab to move back a
field.

If you have questions at any time about what to enter, click Help while
the dialog box is open.

4. Enter information about the problem.

This information is for your recording and reporting purposes. None of
it is required in order for the Power Recorder to monitor data.

5. When you’ve finished, click OK to return to the Site Directory.

The new site is created and listed in the Site Directory where it is
automatically selected.

Before you can use this new site, you must create at least one location in
it so that you can link to the Power Recorder and finish configuring it.
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Creating a New Location

Type a name for
the location.

Select the Power
Type, Nominal
Voltage, and
Frequency at this
location.

Select the format
to be used in
tolerance graphs
in the Disturbance
view.

When you enter location information, you specify the power type and other
information needed to present data correctly. This becomes part of the
Power Recorder configuration.

You can create multiple locations for one site when you want to compare
power at different locations or check for problems at a site. For example, if
you want to characterize a distribution system you would measure power at
the service panel and at several different locations in the same building,

You can also have multiple locations in a site for data downloaded from the
same physical location at different times. When you unlink from a Power
Recorder, you’re given the chance to save downloaded data to a new
location.

To create a new location

1. In the Site Directory (shown on page 22), select the site to which you are
adding the location.

2. Click New in the Location Information area.

The Location Information dialog box appears.

3. Fill in the Location Information dialog box.

Power Recorder System - Location Information [ x|

Location Name IScience Instiuments

Pawer Type IThlee phiase we j

Mominal Voltage

(FT Clutput] I‘I 20Wrms vl

Frequency (% B0Hz " B0Hz Use this box t
B se nIs box 1o

Talerance Format ICBEMA vl indicate which
Feed Phase |Unkmwn -] phase of a 3-phase

service is feeding a
Date Created  11/09/95 Time Created 1501 single phase load.

(] I Cancel | Help

The location name and power type are required.

The date and time are inserted automatically to record when the location
was created.
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If you have questions at any time about what to enter, click Help while
the dialog box is open.

When you’ve finished, click OK to return to the Site Directory.

The new location is created and listed in the Site Directory, where it is
automatically selected.
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Connecting and Linking to a Power
Recorder

When you want to communicate to a Power Recorder, you first establish a
connection and then link to it through the Power Recorder System Software.
You can connect to a Power Recorder in a number of different ways. Your
connection may be:

® A network connection, over a local area Ethernet network

m A direct connection by cable from your PC to a parallel or Ethernet
Power Recorder

®m A dial-up connection over a phone line
m A TCP/IP connection, over the Internet or other Wide Area Network

This section describes how to connect to a Power Recorder in the above
ways, and how to establish a link once you are connected.

Using a Network Connection

When both the PC running the Power Recorder System Software and one or
more Power Recorders are on the same Ethernet network, you can connect
to a Power Recorder through the network.

To make sure a Power Recorder is connected correctly on a network, start
the Power Recorder System Software from a PC on the network and choose
the List Recorders command from the Recorders menu. A dialog box lists
all the Power Recorders that the software can identify. (See page 32.) If the
recorder you want to use is listed, you can link to it.

Power Recorders can be added to an Ethernet network when they are
located within 100 meters of an Ethernet hub, allowing them to
communicate over 10Base-T Ethernet with RJ45 cable.

If you need to verify your network settings, use the Network Control Panel.
Make sure that the Client for Microsoft is installed with file sharing enabled,
that the 10Base-T Ethernet Adapter has been installed, and that you have
associated the NetBEUI protocol to the 10Base-T Adapter.
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Note: Setting up networks is a complex topic, beyond the scope of this
manual. If you need assistance setting up a network of Power Recorders,
contact your network administrator. RPM’s Technical Support can assist you
in adding Power Recorders to an existing network.

Connecting a PC Directly to a Power Recorder

You can connect directly via cable from a PC to either an Ethernet Power
Recorder or to a parallel Power Recorder.

To connect to a parallel recorder, you need the parallel PC-to-Recorder cable
that comes with a parallel recorder.

To connect to an Ethernet recorder, you need a special 2-foot Ethernet cable
from RPM, an RJ45 female-to-female connector, and a 10-foot Ethernet PC-
to-Recorder cable. All of these cables are provided with the Power Recorder.

To connect a PC directly to a Power Recorder
1. Ifyou’re using a parallel recorder:

®  Plug the connector at the end of the parallel PC-to-Recorder cable
into the parallel port (LPT1) on the PC.

m  Plug the other connector end of the PC-to-Recorder cable into the
port on the Power Recorder panel.

If you’re using an Ethernet recorder:

m  Plug one end of the 2-foot Ethernet cable into the Ethernet port on
the PC. (This cable swaps one pair of the communication cable and

must be used when connecting a PC directly to an Ethernet Power
Recorder.)

m  Attach the RJ45 female-to-female connector to the other end of the
RJ45 cable.

®  Plug the RPM connector end of the 10-foot Ethernet PC-to-
Recorder cable into the port on the Power Recorder panel.

®  Plug the other end of the Ethernet PC-to-Recorder cable into the
female-to-female connector.

m  Make sure the Power Recorder is plugged into a power source.
2. Turn on your PC and start the Power Recorder System Software.

You’re ready to link to the recorder through the Power Recorder System
Software. (See page 30.)
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Using a Dial-Up Connection

Under Window you can connect to a Power Recorder by using a modem to
dial a computer connected to a Power Recorder via Ethernet on a LAN
(local area network). The LAN can be as small as one PC and one Power
Recorder, or it can be a much larger network.

In order to use a dial-up connection, a PC on the network must be set up as

a Remote Access Server (referred to under Windows as a Dial-Up Server),
and the Microsoft Dial-Up Adapter must be installed on the PC you are
dialing from. If you’re not certain whether your computer has the Dial-Up
Adapter installed, look in the Network Control Panel. If you don’t see it, or if
you need more information, see the topic “Dial-Up Networking” in
Windows 95 online help or see the Windows NT documentation. You
should also sure that the Dial-Up Networking settings match the ones in
your Network Control panel. (For details, see Appendix G. Dial-Up
Networking Settings.)

You can also dial-up your Internet Service Provider and access Power
Recorders which have an IP address and are connected to the Internet. You
must first record 2 Remote Name for the recorder in the Power Recorder
System Software. For details, see “To associate a Remote Recorder with a
TCP/IP address” below.

To set up a computer as a Dial-Up Server on the network

1. On the computer which will be the Dial-Up Server, open the Dial-Up
Networking folder.

(In Windows 95, double-click the My Computer icon to see the folder
for Dial-Up Networking. Then double-click the Dial-Up Networking
folder to open it.)
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2. In the Dial-Up Networking window, choose Dial-Up Server from the
Connections menu.
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The Dial-Up Server dialog box appears.
3. In the dialog box, select Allow Caller Access.
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4. Click the Server Type button.
5. In the Server Type dialog box, select PPP as the type of dial-up server.

I

6. Click OK.
7. Open the Network Control Panel and make sure your network settings
support dial-up networking.
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The Dial-Up Adapter and appropriate protocols must be installed on the
server. If the Dial-Up Adapter doesn’t appear in the list, you need to
install it. Use the Add/Remove Programs Control Panel and the
Windows Setup tab to help you install the adapter. (You may need your
Microsoft Windows CD.)

To dial into a network that already has a Dial-Up Server

You can make a dial-up connection from the Windows desktop or from
within the Power Recorder System Software. The steps below describe how
to do so from within the Power Recorder System Software.

1. Start the Power Recorder System Software.
2. Choose List Recorders or Link from the Recordetrs menu.

The Available Recorders dialog box opens.

Pawer Heosde bmlem - Aesdabls Hecosdee
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3. Click Dial-Up Connections.

The Dial-Up Connections dialog box opens.
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4. If you see the connection you want to make, select it and click Connect.
5. If you don’t see the connection you want to make, you need to set it up.
In the Dial-Up Connections dialog box, click New Connection.

You see the same dialog box you would see if you were creating a
connection starting in the Dial-Up Networking window.

Complete the screens that appear, entering a name for the connection
and the number you will dial to make it.

When you’re finished, the name of the new connection appears in the
Dial-Up Connections dialog box. Select it and click Connect.

After you establish the dial-up connection, Power Recorders on that network
appear in the Available Recorders dialog box.

If the connection doesn’t go through after you click Connect, you may need
to check the properties of your dial-up connection in the Network Control
Panel.
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Setting Up a TCP/IP Connection

If you’re running Windows 95 or Windows NT 3.51 or later, you can use a
TCP/IP connection to connect to a Power Recorder. This allows you to
connect over the Internet or other Wide Area Networks (WAN).

A TCP/IP connection has two requirements:

An IP address must be assigned to the Power Recorder.

Once an IP address is associated with a Power Recordert, it remains with
that recorder unless it is explicitly changed. The IP address must be a
unique IP address not used for any other equipment on the Internet.

A remote name must be assigned in the Power Recorder System
Software that associates the Power Recordet’s serial number with the IP
address.

This must be done in each installed version of the Power Recorder
System Software that will access the Power Recorder using TCP/IP.

To assign a TCP/IP address to a Power Recorder

TCP/IP settings must be assigned to a Power Recorder over a local network
before they can be used to connect to it over the Internet.

1.

If you do not already know the unique IP address to be given to the
recorder, get it from your system administrator.

Install the Power Recorder on your local network.

If you are using a single Power Recorder with an Ethernet connector,
connect it to your PC. The recorder and PC form a local network.

Start a PC that contains the Power Recorder System Software, and start
the software.

From the Recorder menu, choose List Recorders.

The software automatically browses the network for recorders and lists
the ones it finds in the dialog box, by serial number.

In the list of Available Recorders, select the Power Recorder to which
you want to give an IP address.
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7. Click the Settings button.

The Connection Settings dialog box appears.

Setlings

— Metwork
Connected via MetBEL oh Lana 7

- TCR/IP Sefting
IP Adcress 192 188 1 10
SubretMask [ 255 295 255 224
Gateway W2 188 1

— Multiple Interval Preference
I aximurn Possible Mumnber of Intervals: 16

I aximmurm Mumnber of [ntervals Dezired |1 B 3:

~ Recorder Mame

Recorder Name IHF'M Power Fecorder

Cancel I Help | Ok |

8. Enter the TCP/IP settings in the dialog box and click OK.
The settings are copied into the Power Recorder.

Be sure to enter an IP address and Subnet Mask. These allow you to use
a TCP/IP connection over your Local Area Network.

The Gateway is also necessary in order to communicate with computers
and networks beyond your local area network, such as through the
Internet or other Wide Area Network.

Caution: If you enter the wrong TCP/IP settings, the Power Recorder
will not be able to be accessed through the IP address. You can return to
this dialog box to check or change the settings when you are linked to
this recorder.

To associate a remote Power Recorder with a TCP/IP address

Before you can access a Power Recorder using TCP/IP, you must associate
it’s serial number with an IP address in the Remote Names dialog box in the
Power Recorder System Software. After you create this association, the
software will recognize the IP address when it browses for available Power
Recorders on a Wide Area Network.

To complete this procedure, you need to know the IP address of the Power
Recorder.
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the File menu.

The Remote Names dialog box appears.
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Enter the serial number of the Power Recorder in the Remote Name

Enter the IP address in the TCP/IP Address field.
Click the Add button to add the Remote Name to the list.

Click Close when you are finished.

In the Power Recorder System Software, choose Remote Names from

TROUBLE-
SHOOTING
TIP

If you have trouble establishing a TCP/IP connection, you can test it with
the Microsoft Ping Utility. If you cannot “ping” the recorder outside of
the software, you should recheck your network settings.

If you’re running under Windows NT and your TCP/IP connections
don’t work, open the Network Control Panel. On the Protocols tab, select
the TCP/IP protocol and click Properties. Then select the WINS
Address tab and make sure the box Enable LMHosts Lookup is marked.
This setting allows Remote Names to be handled under Windows NT.
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Linking the PC to a Power Recorder

Linking establishes communications between the PC and the Power
Recordet.

You link whenever you want to:

Configure the Power Recorder or check the present configuration
settings in the Power Recorder.

Inspect real-time data about the power with the Scope tools.

Download data collected by the Power Recorder during the monitoring

period.

NOTE

If you plan to download and save data in the PC, or if you want to use
configuration settings you’ve already entered in the Site Directory, make
sure the database you want to use is open. (See page 17.)

To link the PC to a Power Recorder

1.

Click the Link button in the toolbar or
choose the Link command from the
Recorder menu.

The software looks for Power Recorders in this order: first, it looks on
any local area network, then it checks the list of Remote Names and
establishes any TCP/IP connections, and finally, it looks for a parallel
connection.

If it finds only a connection to a parallel Power Recorder, the Link dialog
box shown in step 4 appears.

If it identifies any other Ethernet Power Recorder(s), whether over a
network, through an established dial-up connection, or through a
TCP/IP connection, it displays all available Power Recorders in the
Recorder Selection dialog box.
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2,

4,

5.
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If you want to dial up a Power Recorder on a remote network that’s not
now shown in the list, click Dial-Up Connections and select the
appropriate connection to use.

The Power Recorder System Software dials the connection you indicated
and contacts the appropriate Power Recorder.

After the connection is made, you are returned to the Recorder Selection,
and the name(s) of the Power Recorder(s) appears in the list.

In the List of Recorders, select the Power Recorder you want and click
the Link button.

The Link dialog box opens and shows information about the Power
Recordet.
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If you need to configure a Power Recorder or set or change monitoring
settings, turn to the next section, “Configuring the Power Recorder.”

Click OK to complete the link.
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What Next?

Once you’re linked to an installed Power Recorder, you can use the Scope
and Analysis tools to view real-time power and download data. (For details,
see “Using the Power Recorder System Software Tools: An Overview” on
page 77.) Or, if the Power Recorder was previously installed and has been
collecting data over a period of time, you can download it now. (See
“Downloading Data to the PC,” on page 65.)
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A Power Recorder must be configured for the specific location where it is
installed. Configuring the Power Recorder sets the nominal voltage, power
type, feed phase (for single-phase power), and specifies information about
the site and location you’re monitoring. It also lets you see whether the
Power Recorder already contains data from a previous installation so that
you can reset it if you want.

Configuration requires the use of a PC with the Power Recorder System
Software installed.

This section describes how to configure the Power Recorder, including how
to:

B Review the current configuration settings. (See below.)
m  Make any changes to the configuration. (See page 41.)
®m  Specify when monitoring should take place. (See page 41.)

Instructions for installing the Power Recorder at a facility begin on page 45.
If you prefer, you can install a Power Recorder before configuring it.

Reviewing the Configuration Settings

To review configuration settings in a Power Recorder

1. Click the Link button in the toolbar or choose the | ==
Link command from the Recorder menu.

Lerguiar Hpra FRE[R] ¥
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Any notes about
the problem at the
site appear here.

Location information
describes the specific
panel you're
measuring. This
information can be
changed in the
Location Information
dialog box.

2,

In the List of Recorders, select the Power Recorder you want and click
the Link button.

The Link dialog box opens and shows the configuration settings now in
the Power Recorder. (If you need more details about the linking process,
see page 30.)
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The About buttons shows the current version of the software
and shows what measurement options are installed in this
Power Recorder.

Approve or change the configuration.

You must make sure the Power Type is correct. Other changes can be
made now or later.

m If the configuration settings are accurate, click OK to accept them
and complete the linking process.

m  If you want to change the configuration settings, click Edit to open
the Site Directory. Then go on to “Changing the Power Recorder
Configuration” below.

NOTE

If the configuration shows that the Power Recorder contains data and you
want to delete it in order to begin measuring at a new location, you must
reset the Power Recorder. To do so, click OK in the Link dialog box to
establish a link to the Power Recorder. Then choose Monitor from the
Recorder menu. In the Monitor dialog box, click Reset. If you want to
make changes to the configuration after resetting the monitor, choose

Link Info from the Recorder menu to return to the Link dialog box.
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Changing the Power Recorder Configuration

When the configuration settings in the Power Recorder aren’t correct, you
can easily change them. You can:

m  Make changes to the present configuration settings in the Power
Recorder, cither to set the correct power type or to make minor changes
like correcting the spelling or adding a contact name or phone number.

B Set up a new site or location and use it to configure the Power Recorder.

m Select existing site and location settings in the database on the PC and
use them to configure the Power Recorder.

To make changes to the configuration settings in the Power
Recorder

1. In the Link dialog box, click Edit.

The Site Directory opens. The configuration now in the Power Recorder
is represented in the Site list by a name with angle brackets around it, like
this: <Computer Site>.

2. To make changes to the existing settings, click Edit for the Site
Information or for the Location Information and enter any changes you
want to make.

To set up a new site or location, click the New button next to Site
Information or Location Information.

For details about entering and changing site information, see page 22.
For details about entering and changing location information, see page
24.

3. When you’re finished, click OK in the Site Directory to return to the
Link dialog box.

Specifying When Monitoring Should Take Place

The last step in configuring the Power Recorder is to specify when
monitoring should take place, and for how long.

If the Power Recorder is currently installed, you can have it begin monitoring
now, or you can arm the Power Recorder to begin monitoring at a specific
time.
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The steps below tell you how to specify when monitoring should occur.

NOTE | For more about starting, stopping, and controlling monitoring, see
“Monitoring Data” on page 60.
To specify when monitoring should take place
1. Choose Monitor from the Recorder menu, or
click the Monitor button.
The Monitor dialog box opens.
Puwes Aecusd Syvlem - Mondi
M craang Cordd
St I [T
{7 B cralar Maw
1™ Mo 2 [ | 4' L
™ Wi e Posesy A ppled |_ [F - 4I|
M ordarng Gishe :
Shitin Lo I
5 uararesey Cound k3
EviCort 45
o b e P Sagie Fepiatin
1 Hee = 1kt
Pacant Complais
|
[l ot S My il
2. Select one of the Monitoring Control options to indicate when
monitoring should begin:
If the Power Recorder is presently installed and you want to begin
monitoring, select Monitor Now. (This is the default setting.)
If the Power Recorder is not yet installed, select one of these:
Select Monitor at: and enter a specific date and time.
Select Monitor After Power Applied: and enter the number of minutes
after power is applied to the Power Recorder when monitoring should
begin.
If you select Monitor After Power Applied, you must disconnect power
NOTE from the Power Recorder and then reapply the power before monitoring

and connected to the wiring.

3. In the Monitoring Period box, select how long the monitoring should
continue.
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4. Click Start to accept the settings you entered in this dialog box.

You must click Start in order for any of the Monitoring Control Settings
NOTE
to be sent to the Power Recorder.

If you selected Monitor Now, monitoring begins immediately.

If you selected Monitor at or Monitor After Power Applied, Amwed
appears as the Monitor Status.

5. When you have finished, click Close.

6. If appropriate, click the Unlink button in the
toolbar or choose Unlink from the Recorder
menu.

If you’ll be disconnecting the PC from the Power Recorder now, be sure
to unlink the two first. For details, see page 71.

What Next?

If you haven’t yet installed the Power Recorder at the facility, you can do that
now.

If the Power Recorder is already installed, you can use the Power Recorder
System Software to check the connection to power and to view and measure
waveforms, harmonics, power vectors, impedances, and phase rotation. (See
“Using the Power Recorder System Software Tools: An Overview” on page
77.) Or, if the Power Recorder has been collecting data over a period of time,
you can download it now. (See “Downloading Data to the PC,” on page 65.)
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Facility

To install the Power Recorder at a facility, you follow the basic steps listed
here. Each of these steps is described in detail on the next pages.

To assure proper grounding of the Power Recorder case, it is important to

CAUTION follow the sequence shown below.

1. Select and attach appropriate current clamps to the Power Recorder. (See
page 46.)

2. Select and attach appropriate voltage probes to the Power Recorder. (See
page 49.)

3. Put the Power Recorder in place and plug the power cord into a properly
grounded receptacle. Start by connecting the power cord to the Power
Recorder panel and then to the instrument power; then observe the
power-up sequence of the LEDs. (See page 51.)

4. Connect the Power Recorder to the wiring, starting by first connecting
the ground probe to the distribution system ground, then connecting the
neutral probe to neutral, and then connecting the current clamps and the
voltage probes. (See page 53.)

Note: The ground wire is isolated from the instrument power cord
ground.
You’ll find diagrams of the wiring for various power configurations on
page 56.
5. Check to see that the connections are established correctly. (See page 58.)
BEFORE YOU 11 addition to being physically installed at a facility, the Power Recorder
LEAVE AN also needs to be configured to measure and store data about a particular
INSTALLED site and location. If you haven’t yet configured the Power Recorder,
POWER follow the steps starting on page 39.
RECORDER
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Select and Attach Appropriate Current Clamps to the
Power Recorder

1. Select the current clamps you want to use.

Choose the clamps that are in the range of current you’re expecting, and that
will fit in the physical space around the wires. The table below provides
guidance to help you select the best clamps to use.

Choose one clamp for each phase, one for neutral (if appropriate), and one
for ground.

Current Clamp

Current Range and
Opening Size

Uses

5 Amp (#3005 and #3005R)

0.1 Ato 5 Amps
RMS

Cable diameter
0.78”

Measuring very low
currents, such as when
connecting to ground
conductors.

Connecting to a current
transformer (CT).

40 Amp (# 3014 and # 3014R*)

0.1 Ato 40 Amps
RMS

Cable diameter 0.78”

Measuring moderate
currents such as
single-phase branch
circuits.

1000 Amp
(# 3100 and # 3100R*)

1 to 1000 Amps
RMS

Jaw opening 2.0”
diameter

Fits most applications.

Useful in most cases,
except when the space
is inadequate

3000 Amp
(# 3300 and # 3000R*)

1 Amp to 3000
Amps

Jaw opening 1.97” x
5.31”

Connecting to high
currents with busbars
or large wires.

*
The “R” version of this clamp includes a 10-foot interface cable required to connect this clamp to the standard

model Power Recorder.
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Current Clamp

Current Range and
Opening Size

Uses

2 Amp to 100 Amps

Flexible current
transformer, 24”
long.

Getting around cable
bundles and large
busbars.

/ —
\\\@
‘ ‘QE%:/

1000 Amp (# 3210)

20 Amp to 1000
Amps

Flexible current
transformer, 24”
long.

Getting around cable
bundles and large
busbars.

>

1000 Amp (# 3212)

20 Amp to 1000
Amps

Flexible current
transformer, 48”
long.

Getting around cable
bundles and large
busbars.

/,

/(j)

5000 Amp (# 3310)

100 Amp to 5000
Amps

Flexible current
transformer, 24”
long.

Getting around cable
bundles and large
busbars.

5000 Amp (# 3312)

100 Amp to 5000
Amps

Flexible current
transformer, 48”
long.

Getting around cable
bundles and large
busbars.
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2. Attach the current clamps to the Power Recorder.

If you’re using a standard Power Recorder with flexible clamps, you
attach the clamps directly to the recorder.

Attach each clamp to the appropriate color-coded connection on the
front panel of the recorder. You'll feel the self-locking ends snap into
place when the connection is made, and the arrows on the clamp and the
connectors will line up.

If you’re using a standard Power Recorder with rigid style clamps, use
the 10-foot interface cable that came with the clamp.

m  Connect the interface cable to the appropriate connection on the front
panel of the recorder, and then connect the other end of the cable to the
clamp. You’ll feel the self-locking ends snap into place when the
connections are made.

Color? | Phase Single | Split 3-phase | 3-phase |2 2-
- Single- | Wye Delta Element | Element®
phase | phase
Black A X X X X X X
Red B X X X
Blue C X X X
White | Neutral X
Green | Ground X X X

If you’re using a Power Recorder in a Hostile Environment Enclosure,
you use a Current Interface Cable to attach the clamps to the recorder.

Start by plugging the end of the gray Current Interface Cable into the
gray port on the end of the Power Recorder.

Attach each clamp to the appropriate color-coded lead for the phase or
wire to which you’ll connect. You’ll feel the self-locking ends snap into
place when the connection is made, and the arrows on the clamp and the
lead connectors will line up.

? These color codes are used throughout the United States. For color codes used outside of the United States, see
Appendix H. International Color Codes.

? Attach the third clamp around the black and blue wires. In cases where only two currents are available, the
third current can be obtained by putting a clamp around the two existing currents. The residual current equates

to the missing current.
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Note: If you’re using flexible current transformers (Flexi-CTs) with the
Hostile Environment Enclosure, you must use Reliable Power Meter’s
Flexi CT Pod Adapter, model number 3533.

Selecting and Attaching Appropriate Voltage Probes
to the Power Recorder

1.

Select the voltage probes you want to use.

The probe you choose will depend on the type of wire or lug to which you
are connecting. The table below provides guidance to help you select the best

probes to use.

Choose one probe for each phase, one for neutral (if appropriate), and one

for ground.

Voltage Probe

Uses/Comments

Crocodile-type voltage
probe (# 3601)

Supplied with the Power Recorder.

Universal probe, can be used in most
situations.

Suitable for rectangular/round cross
sections to 3/4” wide.

G

Syringe Stud-type voltage
probe (# 3605)

Use this probe when you have accessibility
to a stud sizes up to 3/8". Provides secure,
captive contact to the stud.

(This optional probe can be purchased
through Reliable Power Meters.)

]

Threaded Stud-type voltage
probe (# 3606)

Use this probe to connect to studs of 3/8" or
1/2” diameter.

(This optional probe can be purchased
through Reliable Power Meters.)

=

Side-clamp voltage probe
(# 3607)

Connecting to flat busbar services.

Adjustable jaw for conductors up to 3/8”
diameter.

(This optional probe can be purchased
through Reliable Power Meters.)

49



Power Recorder System User Guide

Voltage Probe

Uses/Comments

Battery-type voltage probe
(# 3602)

This is a general-purpose probe that can be
used in a variety of circumstances.

(This optional probe can be purchased
through Reliable Power Meters.)

Plunger type voltage probe

Use this probe when you are connecting to
a set screw head or a machine screw.

Crocodile jaw for screws up to 3/8"
diameter.

(This optional probe can be purchased
through Reliable Power Meters.)

(#3608)
Use this when you are required to use a
T fused probe.
In-line fuse holder This fuse holder has a replaceable 28 mm,
(#3641) 0.25 amp 200,000 AIC fuse, for use with

any of the voltage probes listed above.

(This optional fuse holder can be purchased
through Reliable Power Meters.)

on the Power Recorder.

Attach the voltage probes to the Power Recorder.
If you’re using a standard Power Recorder:

m  Slide the connector on the color-coded voltage lead into the connector

m  Slide the other end of the voltage lead onto the probe you selected.

50




Installing the Power Recorder at a Facility

Color* | Phase Single- | Split 3-phase | 3-phase |2". 2-

phase |Single | Wye Delta Element | Element
-phase

Black A X X X X X X

Red B X X X

Blue C X X X

White | Neutral X

Green | Ground X X X X X

If you’re using a Power Recorder in a Hostile Environment Enclosure,
you use a Voltage Interface Cable to attach the voltage probes to the
recorder.

m  Start by plugging the end of the orange Voltage Interface Cable into the
orange port on the end of the Power Recorder.

m  Slide the connector on the end of the voltage probe into the lead on the
cable.

Putting the Power Recorder in Place

1. Position the Power Recorder within ten feet of the monitoring location.

The Power Recorder can be set on the floor or a table, or it can be
attached to a pole or another surface. If necessary, secure the Power
Recorder to a pole or other mounting surface. (RPM has optional
mounting brackets-product # 4008-and a security cable to assist you in
mounting and securing the unit.)

2. Plug the Power Recorder into a power source.
m  Connect the power cord to the Power Recorder panel.

®m  Then connect the power cord into a propetly grounded wall outlet.

Be sure to plug the power cord into the Power Recorder panel

CAUTION BEFORE connecting it to an outlet.

3. Plug the power cord into a propetly grounded wall outlet.

* These color codes are used throughout the United States. For color codes used outside of the United States, see
Appendix H. International Color Codes.
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If the Power Recorder has been armed to begin monitoring a certain
amount of time after power is applied, that time begins when you plug
the Power Recorder into a power source. (For more about arming the
monitor, see “Specifying When Monitoring Should Take Place” on page
41, or “Monitoring Data” on page 60.)

Observe the Current and Voltage LEDs.

If you’re using a standard Power Recorder, these LEDs are on the panel
of the recorder. If you’re using a Power Recorder with a Hostile
Environment Enclosure, the LEDs are on the pods of the Interface
Cables.

All LEDs should flash ON, then OFF, and then each should turn ON
and OFF in sequence. The LEDs will then remain on if you make a
secure connection and there is significant voltage and current.
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Connecting the Power Recorder to the Wiring

After you’ve assembled the clamps, probes, and interface cables (if
appropriate), and have attached them to the Power Recorder, you’re ready to
connect the clamps and probes to the wiring. (Wiring diagrams are provided
on page 50.)

1. Install the current clamps around the appropriate conductors.

Examine the conductors you’re about to connect to and determine
whether you should attach the current clamps to the phase wires before
SAFETY |you connect the voltage probes. Because they are clamped around wires,

TIP current clamps are usually more secure than voltage probes. In most
cases, you should install the current clamps first. If, however, it will be
easier or safer to attach the voltage probes first, you can do steps 4 and 5
before completing steps 2 and 3.

Use the color-coding on the leads to help you install the clamps around the
correct phase wires.

Connect this color lead...’ ...to the clamp or probe you’ll
connect to
Black Phase A
Red Phase B
Blue Phase C
White Neutral
Green Ground

Make sure the current clamps and voltage probes are paired correctly. The
CAUTION leads for the current clamp and voltage probe of the same color should be
attached to the same phase wire or busbar.

> These color codes are used throughout the United States. For color codes used outside of the United States, see
Appendix H. International Color Codes.
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Check the range light (LED) for each clamp.

The connection panel on the Power Recorder or the pod at the end of the
Current Interface Cable contains range lights for each lead. When you
connect to power, the range light will indicate whether the amount of current
in the line is between 5% to 90% of the range that can be measured by the
clamp.

If the range light is steady ON, you know the clamp you’ve selected is
presently within the range of the measured current.

If the range light is blinking, the current may be beyond the range that this
current clamp can measure. Consider a different current clamp with a higher
range.

If the range light is OFF, first check to make sure that the Power Recorder
is plugged in. If it is plugged in and the panel is under normal load, you may
need a clamp that can measure lower ranges.

If the range light is OFF and you are measuring ground or neutral
current, the current may not be registering. Use the most sensitive clamp
you have. If the range light remains off, you can use the Waveforms tool in
the Power Recorder System Software to check for current. (With the PC
linked to the Power Recorder, open the Amps window in the Waveforms
view. Select the ground or neutral current trace; draw a small selection
rectangle around the trace, and click the Magnify tool to zoom in and inspect
the current trace.)

Connect the voltage probes to the phase conductors.

Use the color-coding on the leads to help you connect the probes to the
correct phases, neutral, and ground. (See the table above, in step 1.)

SAFETY
TIP

Make sure the voltage probes and current clamps are paired correctly.
Calculations are made in pairs and cannot be changed after data is
recorded. The leads for the voltage probe and current clamp of the same
color should be attached to the same phase wire or busbar.

Although incorrectly-paired probes and clamps cannot be compensated
for after the data is collected, inadvertently connecting a voltage probe
and current clamp pair to the wrong phase can be compensated for prior
to collecting data. In such a case, you don’t have to physically change the
position of the probe and clamp. The Power Recorder still collects all the
data it needs, and you can use the Scope Phasors tool to make sure
connections are accurate and make any necessary changes electronically.
(For details, see page 92.)
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Check the LED for each phase to make sure a connection is
established.

The connection panel on the Power Recorder or the pod at the end of the
Voltage Interface Cable is equipped with LEDs for each phase that indicate
when a connection is established with the wire.

When the light is ON, you know that the connection is secure and that
voltage is present.

When the light is OFF, check to make sure the Power Recorder is plugged
in. Next check the connection between the probe and the line to make sure it
is secure. If it is secure, there may be a problem with the probe: remove the
probe and try another one. If the LED still does not light, there may be no
voltage in the line. Use a voltmeter to check for voltage. (Note: You can link
to the recorder and open the Phasor window to verify the correct pairing and
rotation of the currents and voltages. If they are incorrect, use the tools in
the window to swap connections and change polarity. For more information,
see page 92.)
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Wiring Diagrams

The wiring illustrations included here are for the standard power
configurations that are selectable in the Power Recorder System Software.
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Finishing Up

Before you connect the recorder to a PC running the Power Recorder
System Software, or before you leave the Power Recorder to accumulate data
at the facility, double-check the connections.

Double-check these connections:

m  Make sure the current clamps are secured and completely closed around
the conductors and that the range lights (LEDs) on the Power Recorder
or the Current Interface Cable are on.

m  Make sure that the Voltage LEDS on the Power Recorder or the Voltage
Interface Cable LEDs are on.

m  Make sure that the voltage and current leads are paired correctly. For
example, the black voltage lead and the black current lead should both be
attached to the Phase A conductor.

If necessary, lock the Power Recorder in place.

If you’ll be leaving the Power Recorder in an unsecured area on-site, it’s a
good idea to lock it in place. Reliable Power Meters offers a locking security
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cable specifically created for use with the Power Recorder. For information,
contact Reliable Power Meters and ask about item # 4006.

Make sure that you have tagged, labeled, and installed appropriate warning
Warning signs at the monitoring location. Individuals entering the area may be
unaware of the high voltages involved in monitoring.

What Next?

If you have not yet configured the Power Recorder, if you want to observe
and check the connections, or if you want to use the Scope tools to examine
initial conditions, your next step is to connect and link the Power Recorder
to a PC running the Power Recorder System Software. (For details, see
“Connecting and Linking to a Power Recorder” on page 27 and
“Configuring the Power Recorder” on page 39.)

If you know you’re going to take long-term measurements, the Power Recorder
has already been configured and armed, and you’re confident about the
connections to power, you don’t have to connect to and link the Power Recorder
to a PC running the Power Recorder System Software now. You can leave the
Power Recorder on-site to collect data. Monitoring will start at the time you
specified. (For more about monitoring and downloading data, see page 60.)
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This section describes some basic information you need to know when
monitoring data over time and downloading data to your PC. It includes how
to:

m Start and stop the monitoring of data while the Power Recorder is
installed.

m  Reset the Power Recorder to clear all data from it.

m  Download information that’s been collected and stored in the Power
Recordet.

Monitoring Data

As a final step in configuring the Power Recorder, you used the Monitor
dialog box to indicate when monitoring should occur. (See “Specifying When
Monitoring Should Take Place” on page 41.)

The steps below describe how to start, stop, or resume monitoring, and how
to change when monitoring will occur.

Once monitoring begins, it continues until the monitoring period ends, you
unplug the unit, or you use the Power Recorder System Software to stop the
monitoring.
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To start monitoring now

If a PC running the Power Recorder System Software is linked to the Power
Recorder, you can start and stop monitoring through the software.

1.

Choose Monitor from the Recorder menu or
click the Monitor button.

Power Recorder System - Monitor

— Monitoring Control
(% kanitor Mow
" Monitor at: 04,0340 16:43:25
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[ &utomatic Rollaver I wirap fround
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 Monitoring Status

Status: Reset
Surnmary Caunt: 0
Event Count: 0

Monitaring Period Sample Rezolution
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0

&

25% 50% 0% a0z

The Monitor dialog box appears.
If necessary, click Reset to clear existing data from the Power Recorder.

You can tell when the Power Recorder contains data, because
information about the data appears in the lower part of the dialog box.
You'll see data in the Summary Count, Event Count, and Percent
Complete fields.

In most cases, you’ll want to reset the box before continuing. If you
paused the monitoring process and want to continue it without resetting,
use the Resume button instead of the Monitor Now button. (See “To
resume monitoring after pausing it” below.)

In the Monitor dialog box, click Monitor Now.
Click Start.
The Power Recorder begins measuring and storing data.

If the Power Recorder contains data and you didn’t click Reset, a
message asks you to confirm that you want to reset the Power Recorder
and delete the existing data.
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To stop or pause monitoring

1.

If necessary, click the Monitor button to open the
Monitor dialog box.

Click Stop.
The Power Recorder stops monitoring until you start it again.

The monitoring status appears as pazused in the dialog box.

Power Recorder System - Monitor

— Monitoring Control
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Event Count: 0

Monitaring Period Sample Rezolution
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0

&

25% 50% 0% a0z

Note: Although the monitoring stops, the monitoring period time clock
continues. For example, if the monitoring period is one hour and you
stop the monitoring after 15 minutes and resume it 15 minutes later, 30
minutes of the monitoring period will have elapsed, even though data
was collected for only 15 of those minutes. There will be no data for the
portion of the monitoring period during which monitoring was stopped.
When you look at long-term summaries, you will see a blank portion for
the paused period of the monitoring interval.

To resume monitoring after pausing it

1.

If necessary, click the Monitor button to open
the Monitor dialog box.
Click Resume.

The Power Recorder begins monitoring again. The new data is collected
and appears at the correct point in the monitoring session.
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Note: If you want to remove the data from the Power Recorder that’s
been collected so far, you can click Reset. The monitoring session is
then canceled, and you can begin it again.

To arm the Power Recorder or change the monitoring settings

When you want monitoring to begin at some point in the future, you arm the
Monitor by entering information in the Monitor dialog box.

You can arm the Power Recorder to begin monitoring at a particular date
and time, or to begin monitoring a certain number of minutes after power is
applied to the Power Recorder. This is usually the last step in configuring the
recorder, and is described under “Specifying When Monitoring Should Take

Place” on page 41.)

You can also change these monitoring settings when appropriate.

1. Choose Monitor from the Recorder menu, or

click the Monitor button.

The Monitor dialog box opens and shows the current settings.

Power Recorder System - Monitor

— Manitaring Contral
(*) Monitor Mow
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B High Speed Capture

— Monitoring Status
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Summary Count; 0
Event Count: 0

Sample Resolution
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0

100%

&
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2. In the Monitor dialog box, make any changes to the Monitor Control
options that indicate when monitoring should begin:

Select Monitor at: and enter a specific date and time.

Or select Monitor After Power Applied: and enter the number of
minutes after power is applied when monitoring should begin.
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3. In the Monitor Period box, select how long the monitoring should
continue.
4. Click Start to accept the settings you entered in this dialog box.
You must click Start in order for any of the Monitor Control Settings to
be sent to the Power Recorder. If you close the dialog box without
clicking Start, the settings you entered are discarded.
REMEMBER

In addition, if you selected Monitor After Power Applied, you must
disconnect the Power Recorder and then reapply the power before
monitoring will begin.

To check the status of monitoring

You can check the status of monitoring at any time.

v

The Monitor Status
shows if the recorder
is monitoring,
stopped, complete,
armed, or paused.

Choose Monitor from the Recorder menu, or
click the Monitor button.
The Monitor dialog box opens.

Power Recorder System - Monitor ' x|

| Monitoring Control

) bonitor Mow Start - Close
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| Minutes Fauser
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[ &utomatic Rollaver I wirap fround —_—
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completed.
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Downloading Data to the PC

You can download from the Power Recorder to a PC running the Power
Recorder Software while the Power Recorder is installed at a facility, or you
can remove the Power Recorder and download from it at another place, such
as your office.

There are several different ways in the Power Recorder System Software to
download:

B You can use the Download command to download some or all data from
the Power Recorder.

B You can use the Download command to download the summaries first,
and then use the Analysis tools to download a portion of the events.

®  When you are checking to see if Monitoring is complete, you can use the
Download button in the Monitor dialog box to download some or all
data from the Power Recorder.

®  When you’re linked and you choose one of the Analysis tools, you are
given the option to download data that’s been collected since you last
downloaded.

If you have the Polling/ Annunciation addition to the Power Recorder
System Software, you can use the polling features to automate the process of
downloading from one or more Power Recorders. For details, see the
Polling/ Annunciation Software Guide ot see “Using the Polling Software” in the
online help.

NOTE

Make sure you have enough free space available on your hard disk before
downloading (50 MB is recommended). Most Power Recorder System
databases are 3 to 4 MB in size, but some can be as large as 25 MB.

As long as you are linked to a Power Recorder, additional data that you
download is stored under the same location name in the database. When you
unlink, that location in the database becomes closed—additional data cannot
be merged with it. Downloading does not affect the data in the Power
Recorder. Until you reset the recorder, you can relink and retrieve the data
again, including additional data that has been monitored.
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Select the summaries
you want to
download...

...or select options
here to download
events.

To download some or all of the data from the Power Recorder

1.

r I.'-a-'q.-al|

— T -

Connect and link the PC running Power Recorder System Software to
the Power Recorder.

Click the Download button in the toolbar or

choose Download from the Recorder menu.

In the Download dialog box, select the type of information you want to
download by clicking the appropriate boxes.

You can select the types of summaries you want to download and specify
whether you want to download events. If you select Total Events,
indicate whether you want All events or those events that are Outside
Limits.

If you select Event Summaries, only the amplitude and location of the
events are downloaded, while if you select Events, you will receive the
data needed to display the events as graphs.

If you want to download selected events, see “To select specific events
and download them” below.

In addition, you can specify whether to download the initial scope data.
If you leave this box checked, you download the scope data as it
appeared when monitoring started. If you uncheck this box, the Power
Recorder System Software retrieves the scope data as it was when you
linked to the Power Recorder.
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As you select one or more options, the Power Recorder System Software
determines how long it will take to download that data and gives you an
estimate in the dialog box.

4. When you’re ready to begin, click Download.

To download while checking the status of monitoring

Note: You can download before the end of the monitoring period without
affecting the data in the Power Recorder.

1.

Click the Monitor button to open the Monitor
dialog.

If the monitoring is complete, or if you want to download the data that
has been monitored so far, click Download.

The Download dialog box opens.
Select the types of data you want to download and click OK.

To select specific events and download them

If you don’t want to download all of the events, you can download the event
summaries first and then mark the events you want to download.

1. Use the Download tool or command and download summarties.
2. Click the Analysis button in the toolbar or ] [EE nﬂnl G
choose Analysis from the Function menu. s =

"

The icons for the Tolerance and History windows appear in the
Disturbance view.

67



Power Recorder System User Guide

e | P

(]
[l

3. Double-click the Tolerance or History icon of the window you want to
open.

4. Draw a selection rectangle around the events you want to download.
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5. Click the Download button in the toolbar or
choose Download from the Recorder menu.
In the Download dialog box, Selected Events is already marked, and the
number of events you have selected is shown.

6. Click OK to download the selection.

7. If you want, repeat steps 3 through 6 to select additional sets of events.

To download individual events
You can download events one by one, as you view them.
1. Use the Download tool or command and download summaties.

2. Use the Analysis tools to open the Tolerance or History window that
contains the events in which you are interested.

3. Double-click individual events you want to see.

When you double-click an event, the Power Recorder System Software
downloads data about it and displays it in another window. You don’t
have to use the Download tool or command.

Any linked events are automatically downloaded, as well.
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Removing the Power Recorder

As you work with the Power Recorder System, you may use an individual
Power Recorder which you connect directly to a PC running the Power
Recorder System Software. Or you may use a network of Power Recorders
with a PC that’s connected over the network. The procedures in this section
tell you how to unlink a Power Recorder from a PC, how to disconnect
them, if appropriate, and how to remove the Power Recorder from a facility
when you’re finished using it there.

This section includes information about:

m  Unlinking a PC running the Power Recorder System Software from a
Power Recorder, regardless of how they are connected.

®  Ending a dial-up connection you initiated from with within the Power
Recorder System Software.

m Shutting down the Power Recorder System Software.

®  Disconnecting the Power Recorder from a facility.
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Unlinking a PC From a Power Recorder

When you finish using the PC and Power Recorder System Software to
configure the Power Recorder, inspect scope settings, or download data, you
must unlink the PC and Power Recorder using a command in the software.

If you’re directly connected to a Power Recorder, be sure to unlink through
the software before physically detaching the PC-to-Recorder cable from
either the Power Recorder or the PC. Until you unlink, any data you’ve
downloaded has been placed in a temporary file on the PC. When you
unlink, you tell the Power Recorder System Software whether to keep or
discard that data. If you decide to save the data, it is moved from the
temporary file into the open database. If you decide to discard it, the
temporary file is deleted.

If you are measuring and recording data at several different locations with
the same recorder, you must unlink and then establish a new link after you’ve
moved the Power Recorder. If you are using the same PC with multiple
Power Recorders, you must unlink and then establish a new link with the
next recorder.

To unlink the PC from the Power Recorder
1. Click the Unlink button in the toolbar or choose
Unlink from the Recordetr menu.
If you haven’t downloaded any data, the communication link between
the PC and the Power Recorder ends. You can disconnect the two.
If you’ve downloaded data, the Unlink dialog box opens.

2. Select an option to indicate what to do with the data you downloaded.
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Overwrite Existing Data in Database. This option is available only
when you’ve previously stored scope or analysis data for the site and
location named in the configuration. If you want to replace any data
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previously stored for that site and location with the new data, select the
Overwrite option.

Save Data to Database. If this is the first time you’ve saved data for this
location, selecting this option saves the data under the current location
name. If you’re already saved data for this location, this option lets you
specify the name of a new location in which to store the data. Use this
option when you don’t want to overwrite existing data.

Discard Data. This option discards the data instead of saving it. The
temporary file that has been holding the data is deleted and the database
file remains unchanged.

Click OK.

The communication link between the PC and the Power Recorder ends
and the data is saved or discarded, as you indicated.

Ending a Dial-Up Connection

If you established a Dial-Up Connection through the Power Recorder
System Software, you can end it through the software, as well.

If you established a connection outside of the Power Recorder System
Software, end it as you normally end such a connection.

To end a Dial-Up Connection

1.
2,

Choose List Recorders from the Recorders menu.

In the List Recorders dialog box, select the recorder for which you want
to end the dial-up connection.

Click Dial-Up Connections.

In the Dial-Up Connections dialog box, click Cancel Dial-Up
Connection.
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Disconnecting the PC from a Power Recorder

You can disconnect the PC from a direct connection to a parallel or Ethernet
Power Recorder without exiting the software or turning off the PC.
However, be sure you have used the Power Recorder System Software to
unlink before physically disconnecting the two.

To disconnect the PC from a Power Recorder

1. Unplug the PC-to-Recorder cable from the Power Recorder panel.

2. Unplug the PC-to-Recorder cable or the RJ45 cable from the port on the
PC.

Shutting Down the Power Recorder System Software

When you’re finished using the Power Recorder System Software, exit the
software.

To shut down the Power Recorder System Software

1. Choose Exit from the File menu.

If you’re working with a new database, you’re asked to enter a name
before closing it.

2. Type a name for the database and click OK.

The database closes and the Power Recorder System Software quits.
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Disconnecting the Power Recorder from the Wiring

Use standard high-voltage, high-current safety precautions when
WARNING disconnecting the Power Recorder from the wiring.

To disconnect the Power Recorder from the wiring

1. Remove the voltage probes from the wiring.

2. Disconnect the Voltage Interface Cable from the Power Recorder.
3. Remove the current clamps from the wiring.

4. Disconnect the Current Interface cable from the Power Recorder.

5. Unplug the Power Recorder from its power source.
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Using the Power Recorder System
Software Tools: An Overview

This section provides an overview of the main functions of the Power
Recorder System Software Scope and Analysis tools, and tells you how to use
the Phasors tool to verify connections.

These few pages provide only an introduction. More detailed information is
available on-line as you work. When you want more information about the
information the Power Recorder System Software displays in a window, how
you can customize what you see, and how to work with the tools, press F1 or
choose a command from the Help menu.

NOTE

The specific scope and analysis measurements available from a Power
Recorder depend upon what options are installed in that Power Recorder.
For details about what measurements are available with each model and
option, see the Reliable Power Meters Price List or brochure, or contact
RPM Technical Suport.

Note that your Power Recorder can be easily upgraded to add additional
measurement capabilities. Instructions for installing measurement options
are provided in Appendix D, “Upgrading a Power Recorder with

Additional Measurement Options”.

77



Power Recorder System User Guide

Using the Scope Tools to Inspect Real-Time Power

When you are linked to a Power Recorder, you can use the Scope tools to
display real-time information for the location where the Power Recorder is
installed. (If you’re not linked, you can use the Scope tools to review scope
settings you’ve previously saved in a Power Recorder System Software
database.)

To inspect real-time power
1. Install the Power Recorder.

2. If necessary, connect a PC running the Power Recorder System Software to
the installed Power Recorder.

3. Establish a link between the PC and the Power Recorder.

For details, see “Linking the PC to a Power Recorder.” on page 36.

4. C(lick the Scope button in the toolbar. By

The Scope tool buttons appear at the right of the toolbar. The Waveforms
tool automatically activates, and icons for the Waveforms windows appear
in the window.
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When you click the ...the Scope tools
Scope button... appear here.
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Double-click an icon to open it to a window. For more about working with
icons and windows, see page 12.

The Scope Tools

The Power Recorder System Software includes five Scope tools that let you
assess real-time power conditions.

Waveforms Impedance Power Vector

~ I
B 'T&+| ml[lm,_'ﬁq

Phasors Harmonics

Waveforms displays oscillograph signals of the power. Four windows are
available—one each for Volts, Amps, Watts, and one for Volts and Amps.

Phasors displays one window that shows phasor diagrams for voltages,
currents, and line impedance. The Phasors tool is especially useful for checking
whether the voltage probes and current clamps have been installed correctly.
For details, see “Using the Phasors Tool to Verify Connections” on page 92.
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Impedance displays fundamental and harmonic impedance from the location
to the source, and to the load. When you’ve just installed the Power Recorder,
it takes a few minutes to correctly calculate the impedance. Allow the
impedance windows to refresh for approximately two minutes.

Harmonics displays the instantaneous peak values of the harmonics of each
of the voltages and currents you’re monitoring. You can examine the
harmonics for each phase of voltage and current, as well as the harmonics on
the neutral and ground voltage, harmonics on the neutral and ground currents,
and flicker for each phase of voltage.

Power Vectors displays three-dimensional graphs of VA, VAR, watts, and
distortion in the power you’re monitoring. Both fundamental and total values
are listed in this display.

For more information about the use of a particular Scope tool, activate that
tool in the Power Recorder System Software and press F1 to display the Power
Recorder System Software Help.

Pausing the Scope Sweep

When you’re linked to an installed Power Recorder, the Scope information
refreshes about every four seconds so that what you see is what is occurring
right now. You can temporarily halt updating on the screen in order to closely
inspect waveforms or other information at the moment of capture, or to copy
a picture of a specific graph in a Scope window to the Clipboard to paste it
into a report or other document.

Tip: If you are using a dial-up connection the Scope Sweep is slow. You may
want to halt the Scope Sweep.

To pause or restart the Scope sweep
v Click the Sweep button in the toolbar. el |
L

Once you’ve stopped the Scope sweep, click the button again to restart the
updating of information.
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Capturing Initial Conditions in the Database

When the Power Recorder begins monitoring, it takes a snap-shot of the
Scope’s initial conditions and stores them as part of the power record for each
location in the database. That way you can examine the Scope data off-site, as
well as monitor it on a continuing basis at the facility.

One snap-shot of Scope data is stored for each location in the database. If you
want to capture a different snapshot of the Scope settings, you can tell Power
Recorder to capture the settings you want while you are linked.

To capture initial conditions in the database

v Choose Capture from the Recorder menu, or @I
click the Capture button.

If you want to capture more than one snap-shot of Scope data for the
same location, you can do so by creating multiple location names for the
same location and capturing a snap-shot in each. (First, click the Unlink
TIP button and unlink from the Power Recorder.) You can identify such
multiple locations with sequential names, such as Subpanel 3A-1, Subpanel
3A-2, Subpanel 3A4-3, and so forth. When you unlink and then relink, the
new location is automatically given the name of the last location with a
number appended to the name.
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Using the Analysis Tools

When you want to analyze power quality and consumption over time or view
disturbances, you start by installing the Power Recorder and leaving it at the
facility to collect data. Once the data has been collected in the Power Recorder,
you download it to the PC. You can then use the Analysis tools to check for
disturbances, significant power events, power consumption, and more.

To analyze power data over time

1. Install the Power Recorder at the facility and leave it to collect data over
time.

2. When the data has been collected, connect the PC to the Power Recorder
and establish a link through the Power Recorder System Software.

3. Use the Download tool and download the EE
summaries, or the summaries and the events.

(For details, see page 65.)

4. Click the Analysis button or choose Analysis Elzal.=- Gy
from the Function menu. CIT K o I

The Analysis tool buttons appear at the right of the toolbar. The
Disturbances tool automatically activates, and icons for the Disturbance
History and Tolerance windows appear in the window.

If you’re linked to a Power Recorder, the software may open the
Download dialog box so that you can download data to review with the
Analysis tools.
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When you click the ...the Analysis tools
Analysis button... appear here.
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Double-click an icon to open it to a window. For more about working with
icons and windows, see page 12.

The Analysis Tools

The Power Recorder System Software includes four Analysis tools that display
events and summary information.

Disturbance Distortion
+;H'\-|_ =
e =) I

VIF Summaries  Power Analysis

;

Disturbance tools display graphs of events plotted by Tolerance and History
for each phase.

VIF Summaries displays long-term summary graphs of voltage (VRMS),
current (IRMS), and frequency for each phase.

Distortion displays long-term summary graphs of harmonic distortion of each
of the phase voltages and currents, any imbalance for voltage or current, and
flicker summaries for phase voltages.
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Power Analysis displays graphs showing phase and total watts, demand,
reactive power (VAR), Volts-Amps (VA), and power factor (PF).

For more information about the use of particular Analysis tools, activate that
tool in the Power Recorder System Software and press F1 to display the Power
Recorder System Software Help. You’ll also find some information about
events and summary graphs in Appendix E, Event Tolerance Displays, and
Appendix F, Summary Graphs.

Using Scope and Analysis Data in Reports

You can copy any of the Scope and Analysis graphs into other applications—
such as Microsoft Word or Excel—to include them in reports. You can also
copy the data from these graphs into a text file for further use in a word
processing or spreadsheet document.

The Copy Graphics command on the Edit menu copies the contents of the
active window to the Clipboard as a bitmap file. You can then paste the graph
into another application. If you want to copy the information shown in the
status bar as well, you can copy it separately.

The Copy to Text File command on the Edit menu lets you copy the data from
the active window to a text file.

If you purchased the Report Writer for the Power Recorder System software,

you have a tool that automatically creates reports. For details, see the Repors
Writer Guide.

To copy a black-and-white version of the graph to the Clipboard

If you want to print to a black-and-white printer, you’ll get the best results if
you first display the graphs in Monochrome.

1. Choose Color from the Options menu.

The Change Colors dialog box opens.

Click Monochrome at the bottom of the dialog box.
Click Done.

The current color settings change to monochrome.

Display the graph you want to copy.

N o a M b

Click the Copy Graphics button in the toolbar or
choose Copy Graphics from the Edit menu. =
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The contents of the active window are copied to the Clipboard.
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8. Open the application into which you want to paste the graphic and choose
Paste from the Edit menu.

9. If you want to include the information in the status bar, choose Copy
Status Text while the graph is open.

The contents of the status bar are copied to the Clipboard.

10. Return to the document you pasted the graphic into in step 6, select the
location where you want to paste the information, and choose Paste from

the Edit menu.
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To copy data into a text file

You can copy a text version of the information shown graphically in Power
Recorder System Software windows. If one or more windows are open in a
view, the data from the active window is copied. If no windows are open, and
only the thumbnails appear in the view, the data from all the windows is
copied. This can result in a file containing huge numbers of data entries. (One
VIF summary can include up to 10,800 data entries.)

1. Open the window that contains the data you want to copy.
2. Choose Copy to Text File from the Edit menu.

3. In the dialog box that opens, type a name for the file to which the text will
be copied.

4. Change the directory or drive if you want to save the file in a different
location.

5. Click OK.
The data is copied to the file.

For more information about the data that’s copied from Event Tolerance
and History graphs, see “Saving Event Tolerance and History Data as
Text” on page 115.

Changing the Colors in Graphs

You can change the colors used to display data in Power Recorder System
Software windows. You can also change the display so that graphs are shown
in Monochrome. This allows you to copy one or more graphs for printing on a
black-and-white printer.

Note: You can hide the Min/Max or Average lines by changing them to the
background color. (In Monochrome, the background color is white; in the
default color scheme, it is black.)

To customize the color settings used in the Power Recorder
System Software

Tip: You may want to open a Scope or Analysis window before changing
colors. That way you can see the effect of changing colors immediately.

1. Choose Colors from the Option menu.
2. Sclect the screen element you want to change.

The color now active for the selected element shows in the box on the
right.
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3. Click Change Color to open the Color dialog box.

4. Click the color you want, or use the arrow keys to select it.

Oy, if you want, click Define Custom Color and define the color you
want.

5. Click OK to return to the Change Colors dialog box.
If you have a graph open in the main window, you’ll see the new color.
6. Repeat steps 2 through 5 for each screen element you want to change.

7. When you’ve finished, click Done.

If you later want to use the original color settings, open the Color dialog
box and click Defaults.

To display all graphs in monochrome

1. Choose Colors from the Option menu.

2. Click the Monochrome radio button at the bottom of the dialog box.
You'll see the graphs change from colors to monochrome.

Tip: If you want graphs to be surrounded by a gray border, double-click
the Exterior Fills item in the list of screen elements. In the Color dialog
box that opens, select the solid gray box. Then click OK to return to the
Change Colors dialog box.

3. Click Done.
All graphs will appear in black-and-white until you click the Colors setting.

Note: If you previously customized color settings, the software remembers
them when you switch to Monochrome. If you return to color settings, the
settings you selected are returned. If you want to use the original color
settings, click Defaults.
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Setting Preferences

You can change some specialized default options by setting Preferences in the
Power Recorder System Software.

To set preferences

Choose Preferences from the Options menu.

The Preferences dialog box opens.
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2. Specify the settings you want used as your preferences:

Note: The preference settings grouped at the top of the dialog box as
Location Defaults can all be changed for individual locations in the
Location Information dialog box.

Power Type Choose the type of power to be the default for new
locations.

Nominal Voltage Select a standard voltage from the list, or click in the
box and type the voltage you want to designate as the 100% point for the
CBEMA curve or the 0 point for the ANSI curve.

Frequency Choose the frequency to be the default for new locations:
60Hz (U.S.) or 50 Hz (European).

Tolerance Format Select the type of limit curve you want to use on the
Disturbance graphs. The pop-up list includes ANSI, CBEMA, ITIC, and
any tolerance formats you have defined and named using the Edit
Tolerances command on the Function menu.

Language Select the language you want to appear onscreen. This option
only works if the necessary language files are installed.
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Use Last Database Mark this option when you want the last database
you used to open each time you start the Power Recorder System Software.
If you don’t mark this box, a new, empty database opens.

Display Event Links Mark this option when you want links to related
events to display in Tolerance and History windows while you are
inspecting specific events. (Related events appear in small detail insets.)
Unmark this option if you do not want such links to display. (Tip: When
you want to view the position of impulse wave shapes, turn Display Event
Links off for a better picture.)

Monitoring Period Choose the monitor period that you want to be the
default setting in the Monitor dialog box.

3. Click OK.

Changing Multipliers

When you are using a CT (current transformer) or a PT (potential
transformer), you can have the Power Recorder System Software report the
actual current and voltage read-outs by entering the appropriate turns ratio of
these devices as multipliers. When you do so, you should enter the necessary
multiplier for each phase, neutral, and ground.

To change multipliers
1. Choose Multipliers from the Option menu.

The Multipliers dialog box opens.
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2. Enter the multiplier you want to use for voltage and current on each of the
phases and neutral.

3. Click OK.
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Changing Full Scale Settings

If the presentation on a graph is too large or too small, you can change the full
scale values in this dialog box to rearrange how the data is presented in the
windows. These settings can be set or changed at any time without altering
captured data.

To change full scale settings

1. Choose Full Scale Settings from the Options menu.
The Full Scale Settings dialog box opens.
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2. For each of the Voltage and Current fields, enter the volts or amps to be
used as the full scale in the windows.

When you are connected to the Power Recorder, Probe appears as the full
scale current value. This means that the value of the current clamp you
have installed will be used. (You can enter a different value if you want—
for instance, if you are using a 5 amp clamp with a CT.)

3. As the Event Summary Maximum, select the multiplier you want to use to
expand the scale of the amplitude in the Event Summary windows.

This is helpful when you are encountering large voltage impulses and want
to see their relative value. They will not be jammed against the top of the

graph.
4. As the Event Summary Minimum, select the multiplier you want to use to

add negative voltage to the Event summary windows.

When you have significant sags or outages, this allows you to see them
more clearly. They will not be jammed against the bottom of the graph.

5. Click OK.
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Setting the Demand Power Interval

You can set the interval over which watts are averaged on the Demand graph
in the Power Analysis View. You can change this setting even if you've already
downloaded data from a Power Recorder.

Typically, you should set the demand power interval to match that of your
utility. You can then use the Demand graph to determine how best to manage
loads.

To set the demand power

1. Choose Demand Power from the Options menu to open the Demand
Power dialog box.

2. In the Demand Interval field, select the interval you want to use—from 5
to 60 minutes.

3. Mark the option Use 5-minute sliding window if appropriate.

Utilities record demand based on a sliding or non-sliding window. Usually
you will want to turn this setting on or off to match your utility's settings. If
you're not sure what method your utility uses, your utility rate schedule will
tell you.

4. Click OK to accept the changes in this dialog box.

The interval you selected will now be used when you display Demand
graphs.
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NOTE connection mistakes must be corrected before the power is monitored to
ensure accurate data. Voltage and current must be paired correctly.
Checking Phase Rotation
The graphs at the top of the Phasors window indicate whether the probes and
clamps are attached to the correct wires. When they are attached correctly, the
phase angles are A-0°, B-240°, and C-120°, and the vectors representing the
phases rotate counter-clockwise, as shown in the screenshot on the next page.
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Using the Phasors Tool to Verify Connections

You can use the Phasors tool to determine if the current clamps and voltage
probes are correctly installed.

If the polarity of the current clamps is incorrect, or if you have attached
voltage probes or current clamps to the wrong phases, you can make
corrections with the tools in the Phasors window so that the data being
collected can be correctly displayed. This lets you avoid re-entering the panel to
make physical changes to the position of the clamps and probes.

It’s a good idea to link to the Power Recorder and use the Phasors tool to
check and correct any miswiring before you start to monitor data. Some
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If the graphs in the Phasors window show different phase angles, or show the
phases in a different rotation, one or more of the probes and clamps are
connected to the wrong wire.
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Changing Phase Rotation

If the probes and clamps are hooked up incorrectly, you can specify which
connections are incorrect and need to be adjusted through the software.

Two kinds of changes can be made—rotating the position of all three leads, or
swapping the position of two leads.

Rotating. If all three leads are connected to the wrong wires, you can have the
Power Recorder System Software rotate the positions counter-clockwise, so
that the lead for channel 1 shifts to phase C, the lead for channel 2 shifts to
phase A, and the lead for channel 3 shifts to phase B. Rotating a second time
would shift channel 1 to phase B, channel 2 to phase C, and channel 3 to phase
Al

Swapping. If you’ve connected the leads for channel 2 (the red leads) to the
phase C wire instead of the phase B wire, and the leads for channel 3 (the blue
leads) to the phase B wire, you can have the software swap the two channels.
The information coming in on channel 2 will then be interpreted as belonging
to phase B, and the information coming in on channel 3 as belonging to phase

C.

The Phasors window includes two sets of tools for correcting phase rotation
errors:

E— These tools rotate or swap the information for both
voltage probes and current clamps. Use them when

‘BF_TE | a pair of leads is connected to the wrong wire.
Rotate tools >< —
Swap tools I These tools rotate or swap the

\: [~ information for the current clamps only.
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Most of the time, you’ll probably use the Phase Rotate and Phase Swap tools
and make a change that affects a pair of leads. But if you didn’t correctly pair a
voltage probe and current clamp when connecting to the wiring, you must use
the Current Rotate and Current Swap tools in combination with the phase
tools to indicate how the leads are actually connected.
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CAUTION

If you incorrectly paired voltage probes and current clamps, you should
correct this problem before monitoring power to collect data. The Power
Recorder System calculates information about power using both voltage
and current information for each phase.

Individual voltage and current pairs cannot be separated after data has been

collected in the Power Recorder through monitoring.

To rotate the phases

1.

Click the Phase Rotate tool.

Channel 1 moves to phase C, channel 2 moves to phase A, and channel 3
moves to phase B. You’ll see the change take place in both voltage and
current phasor graphs.

If necessary, click the Phase Rotate tool again to rotate the phases another
turn.

To swap phases

1.

Click the Phase Swap tool. *Ei—
L

Channels B and C are interchanged for voltage and current.

If you need to swap channels other than B and C, use the Phase Swap tool
and the Phase Rotate tool until the settings are correct. You can tell when
the necessary changes have been made because the phase angles will be
approximately A-0°, B-120°, and C-240°.

If necessary, use the Phase Rotate tool now to rotate the phases.

To rotate the current

1.

Click the Current Rotate
tool.

Channel 1 moves to phase C, channel 2 moves to phase B, and channel 3
moves to phase A. You'll see the change take place in the current phasor

graph.
Note: If you’ve already monitored data, the Current Rotate tool is not
available.

If necessary, click the Current Rotate tool again to rotate the current
phases another turn.
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Impedance
Graphs

To swap current
1. Click the Current Swap tool. =
sl

Channels B and C are interchanged for current.
If you’ve already monitored data, the Current Swap tool is not available.
If you need to swap channels other than B and C, use the Current Swap

tool and the Current Rotate tool until the settings are correct.

2. If necessary, use the Current Rotate tool now to rotate the phases.

Checking the Polarity of the Current Clamps

The graphs at the bottom of the Phasors window show the impedance for each
of the phases. The values below each graph show the vector’s amplitude and
angle.
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If the impedance is negative (the vector is in either quadrant on the left side of
the graph), the polarity of the current clamps is probably reversed.

Another indication of reversed polarity is if the current phasor is pointing in
the wrong direction by 180°.

NOTE

Before you change the polarity, check to see if there is a generator in the
system. Negative impedances are also indicated if there is an additional
generator in the system. If there is an additional generator, don’t change
the polarity.

If you would like more information about phasors, see the references in
Appendix B, Background Materials.
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Reversing the Polarity

The Phasors window includes tools that correct for reversed polarity. An
Invert tool appears for each of the phases in the power you’re measuring.

To reverse the polarity

1. Click the Invert button for the phase for FII 5
. . +H
which you want to reverse the polarity.
I-
B++E
I-
Lkl

The Power Recorder System Software reverses the polarity for that phase,
just as though you physically inverted the clamp.

2. If necessary, click additional Invert buttons to change the polarity of other
current clamps.
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Appendix A. Glossary

Configuration

The configuration for the Power Recorder specifies information about the
location where power is being monitored, such as power type and feed phase
(for single phase). It can also contain information about the facility where
power is being monitored, names of contacts at the site, and a description of
the problem. Site and location names can also be included. When you link
the a PC to a Power Recorder, the configuration now in the Power Recorder
appears in the Link dialog box.

Database

The Power Recorder System Software organizes information in a database.
Each database can contain information about the power at many different
locations. A Power Recorder System Software database is actually a
collection of files, with one primary file that uses the database’s name. The
files associated with each database are stored together in a subdirectory.

Location

This is the particular panel or branch load where you physically connect the
Power Recorder to measure power. In the Power Recorder System Software
database, locations are organized under S7fes.

Power Recorder

The Power Recorder is the power monitoring unit that you connect to the
power to measure, collect, and store data.

Power Recorder System

The complete power analysis system available from Reliable Power Meters,
including both a PC running the Power Recorder System Software and a
Power Recorder.

Site

A building or other facility, or portion of one, represented by a name in the
database and in the Power Recorder configuration. Sites provide a way to
group information about related locations in your database. You can enter
information about a site, such as an account number and contact name, and
include information about the power problems being experienced at the site.
You can measure power at multiple locations within the same site. (See also
Location.)
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Appendix B. Background Materials

Following is a list of publications and other materials you may find useful if
you want additional background information about the Power Recorder
System.

Practical Guide to Quality Power for Sensitive Electronic Equipment,
EC&M Intertec Electrical Group, 1992. (Available from Reliable Power
Meters.)

Guideline on Electrical Power For ADP Installations, a Federal Information
Processing Standards Publication, U.S. Department of Commerce, National
Bureau of Standards, 1983.

Interaction Between Computer Systems and Their Power Source, A Tutorial
Seminar presented at The Power Sources User’s Conference, by John
Frederick Kalbach.

Practical Guide to Power Distribution Systems for Computers, EC&M
Intertec Electrical Group.

Practical Guide to Energy Efficiency & Reduced Costs, EC&M Intertec
Electrical Group.

Practical Guide to Motors & Motor Controllers, EC&M Intertec Electrical
Group.

Power Quality Reference Guide, Maura C. Ryan, Ontario Hydro, 1988.

IEEE Std. 519—1992, IEEE
Guide for Harmonic Control and Reactive Compensation of Static Power

Convertets.

IEEE Std. 1100—1992, IEEE

Recommended Practice for Powering and Grounding Sensitive Electronic
Equipment.

IEEE Std. C62.41—1991, IEEE
Recommended Practice on Surge Voltages in Low-Voltage AC Power

Circuits.

IEEE Std. 141—1993, IEEE
Recommended Practice for Electric Power Distribution for Industrial Plants
(ANSI) (Red Book)
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IEEE Std. 100-1992, IEEE

Recommended Practice for Powering and Grounding Sensitive Electronic
Equipment (ANSI) (Emerald Book).

IEEE Std. 242-1986

Recommended Practice for Energy Conservation and Cost-Effective
Planning in Industrial Facilities (ANSI) (Bronze Book).

IEEE Std. 399-1990

Recommended Practice for Industrial and Commercial Power Systems
Analysis (ANSI) (Brown Book).

IEEE Std. 493-1990

Recommended Practice for the Design of Reliable Industrial and
Commercial Power Systems (ANSI) (Gold Book).

IEEE Std. 241-1990

Recommended Practice for Electric Power Systems in Commercial Buildings
(ANSI]) (Gray Book).

IEEE Std. 446-1987

Recommended Practice for Emergency and Standby Power Systems for
Industrial and Commercial Applications (ANSI) (Orange Book).

IEEE Std. 602-1986
Electric Systems in Health Care Facilities (ANSI) (White Book).

Guide to Quality of Flectrical Supply for Industrial Installations, Advance
VIE Edition, Subject to Revision, Prepared by Groupe de travail GT2
“Perturbations sur reseaux”, “Disturbances” Working group GT 2, Union
Internationale d’Electrotehermie, Paris, France.

Handbook for Electricity Metering, Edison Electric Institute, 1986.

Computer Electrical Power Requirements, Mark Waller, Howard W. Sams &
Company, 1987.

The Dranetz Field Handbook for Power Quality Analysis, Dranetz
Technologies Incorporated, 1991.

Handbook of Power Signatures, Alexander McEachern, Basic Measuring
Instruments, 1988.
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Appendix C. Updating the Power
Recorder System Software

When you update the Power Recorder System Software with a more recent
version, you must change the software in both the PC and the Power
Recorder. After you update the software in the PC, it will not
communicate with the Power Recorder until you have updated the
software in the Power Recorder.

If you are adding the Polling/Annunciation Software or the Report Writer
Software but are not updating to a newer version of the basic Power
Recorder System Software, you do not have to update the Power Recorder.

CAUTION:
UPDATING
WILL
REPLACE
EXISTING
DATA

m  Updating the Power Recorder System Software will replace the old
sample database (SAMPLE.OMG) with a new sample database. If
you want to keep the old sample database and get the new one, use
the Save As command on the File menu to save the old sample
database under a different name.

m  Updating the software in the Power Recorder will remove all data
from the recorder. Be sure to download and save all data from
the Power Recorder before updating the software.

If you have more than one Power Recorder, you must download
data from each recorder while the current version of the software is
on your PC. If you cannot download data from all recorders before
installing the new version, be sure to keep your previous version of
the Power Recorder System Software.

Requirements

If you are adding the Report Writer Software, you must have Microsoft
Word Version 8.0 or higher installed on the computer that will be used to
generate Power Recorder System reports.
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To update the software in the PC
1. Start Microsoft Windows on your PC.
2. Insert the first installation disk in drive A or B.
3. In the dialog box that appears, type:
= ANSETUP or BI\SETUP

* Be sure to use the correct designator for the floppy drive in
which you inserted the installation disk.

=  Click OK.

®= Follow the instructions that appear on the screen, and swap
diskettes when requested.

The Power Recorder System Software is installed on the hard drive of
your computer and a program group named “RPM” is created.

Note: If you have questions or problems regarding this software update,
please contact Technical Support at Reliable Power Meters (408) 358-5100.

To update the software in the Power Recorder
Be sure to update the software in each of your Power Recorders.

1. If necessary, connect a PC running the Power Recorder System Software
to the Power Recorder.

2. Plug the Power Recorder into a power source.
The recorder must be powered up for at least two minutes before you
install the new software.

3. Turn on your PC and start the Power Recorder System Software.

You do not need to link to the Power Recorder.

4. Press Ctrl-Shift-F7.

This means to hold down the Ctrl and Shift keys and press F7. Then
release the keys.

If you’re connected to a Parallel Power Recorder, the software in the
Power Recorder is updated.

If you’re connected to an Ethernet Power Recorder, the List Recorders
dialog box appears and lists all available recorders.

5. Select one or more Power Recorders for which you want to update the
software and click OK.
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10.

You can use the Shift-Click and Ctrl-Click to select multiple recorders in
the list.

The software in the Power Recorder(s) is updated.

If you’re prompted to disconnect the meter power for 5 minutes, unplug
the power cable to the Power Recorder and wait 5 minutes.

Reconnect the power to the Power Recorder.

The following screen appears:
Ll o e py g nsfnn

T 1 T

[ & Ti% 1 k] iR [
Humbesr o [ iraie n
Click Done.

To confirm that the update was performed successfully, link to the
Power Recorder.
From the Help menu, choose About Power Recorder System.

Make sure the correct versions of the software are shown as installed in
the About box.
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Appendix D. Upgrading a Power
Recorder with Additional Measurement
Options

You can add measurement options to a Power Recorder by updating the
software in it. Before you begin, you need the key diskette that contains the
software. This diskette is provided by Reliable Power Meters when you
purchase the measurement options.

If you're not sure what options are currently in a Power Recorder, link to it
and click the About button in the Link dialog box. You can also choose
About from the Help menu while you are linked to the recorder.

To upgrade a Power Recorder with additional measurement
options

1. From a PC running the Power Recorder System Software, link to the
Power Recorder you want to upgrade.

2. Choose Configure Recorder Option from the Recorder menu.

The Install/Uninstall Recorder Options dialog box appears.
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3. Insert the key diskette containing the software in Drive A or B.

4. Make sure the dialog box reflects the drive in which you inserted the
diskette and click OK.

The Recorder Options dialog box appears.
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Power Hecorder System - Recorder Options Configuration Ed |
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5. To add an option, make sure the box next to it is checked.
(You can also remove an option by unmarking the box next to it.)

If an option is gray, it is not on the key diskette and cannot be installed
or removed.

6. Click OK.

The software in the Power Recorder is upgraded with the measurement
options you specified.
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Appendix E. Event Tolerance Displays

Events consist of Impulses, Waveshape faults, and surges and sags. These
events are created by changes in monitored voltage.

Events are graphed on both Tolerance and History Summary displays. The
Tolerance graph displays events by amplitude versus duration. The
History graph displays these same events by amplitude versus date/time

of occurrence.
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Identical events
displayed in two ways

Types of Graphic Presentation of Events

In general events are shown in three types of graphic presentations:
Transitional, Event, and Impulse.

1. Transitional - where the voltage has not stabilized and the A Rms is
greater than the adaptive threshold value.
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Transition Graphic
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2. Event Graphic - the period between two transitional events. Each Event
graphic is bounded by two Transitional Events.

Events are plotted as dots on the tolerance curves.
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Event Graphic

3. Impulse - high frequency surge typically caused by lightning or switching.
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Impulse Graphic
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Tolerance Curves

All events are mapped on a tolerance curve. These events are marked on the

tolerance curve when summaries are downloaded.

The tolerance curves consist of the CBEMA curve (Computer Business
Equipment Manufacturers’ Association), the ANSI curve (American
National Standards Institute), the ITIC curve (Information Technology
Industry Council). You can create other curves by using the CBEMA, ANSI,
ot ITIC curve as an editing model. (Use the Edit Tolerances command from

the Function menu.)
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Downloading Individual Events and Moving Between
Events

When you view a History or Tolerance graph, some points that indicate
events may appear as X’s. This occurs when only summary data (the
amplitude and location) has been downloaded. If you double click on one of
the X’s while connected to the Power Recorder, the graphic presentation is
downloaded from the Power Recorder and presented on the screen, like this:
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Detailed Graphic of an Event
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After you download such an event, the “x”” on the graph becomes a dot.

Buttons on the graph allow you to “walk” through next and previous events.
Each graphic is downloaded to your PC as you select it.
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If you unlink from the Power Recorder prior to downloading a graphic
(either by placing a selection box around a group of events, double clicking
on a single event, viewing an event, or downloading all events) double
clicking on an “X” will produce an empty graph, like this:
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Event Not Downloaded From Monitor

Using the History Graph to Check for Events at
Specific Dates and Times

While the Tolerance graph displays events by amplitude versus duration,
the History graph displays these same events by amplitude versus
date/time of occurrence.

The History graph can be particularly useful when locating specific dates and
times during the monitoring period to determine if any events occurred.
Anomalies seen in summaries at specific times can therefore be associated
with certain events happening at simultaneous times.

To take advantage of this feature, first view the VIF summary graphs to
identify a period of interest. For example, the next graph shows how a
selection box drawn around a period of interest in an RMS Voltage graph to
identify the exact date and time.
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Summary Graph
Write down the date and time of interest.

Next, open the History Graph, draw a selection box of about the same size,
and move it across the graph until the same date and time appear in the
status bar, as shown in this next graph:
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Event History Graph

Notice whether an event appears in the selection box on the History graph.
If one does, double-click on it see the detailed event, like this one:
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RMS Voltage Min/Max Graph

Saving Event Tolerance and History Data as Text

Event Tolerance and Event History graphs can be saved as text reports.
They are formatted as follows:

Phase A Event Tolerance Summary. June 08, 1994. 22 events.
< Site> (<Location>)

16:27 Jun 08, 1994 17:27 Jun 08, 1994

Number  Type Amplitude  Duration  Date and Time

30 4 203.176 0.000 Jun 08 1994 16:28:00.534
20 4 203.176 0.000 Jun 08 1994 16:28:00.584
40 17 1.953 0.133 Jun 08 1994 16:28:00.525
Graph Event Voltage Seconds Date &

Number Type Amplitude Duration Time

Note: The last digit of the Graph Number indicates the phase—0 indicates
phase A, 1 indicates phase B, and 2 indicates phase C. The sample above
shows data about Phase A events.

Events can be out of numerical sequence. This happens when an event is in
process during a period in which another event occurs.
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Here’s what the event types mean:

0
1

2

4

15
16
17
19
24
25
26
28
29
30

RMS Voltage event, single line graph

RMS Voltage event, min/max graph

Voltage waveform event, single line graph

Voltage impulse event, single line graph

RMS Voltage transition event, single line graph

RMS Voltage transition event, min/max graph

Voltage waveform transition event, single line graph
Voltage impulse transition event, single line graph

RMS Voltage/Current event, single line graph

RMS Voltage/Cutrent event, min/max graph
Voltage/Current waveform event, single line graph
RMS Voltage/Cutrent transition event, single line graph.
RMS Voltage/Current transition event, min/max graph.

Voltage/Cutrent transition waveform event, single line graph.
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Appendix F. Summary Graphs

The Power Recorder System Software summary graphs are powerful tools in
both the Power Quality and Power Flow environments. These graphs not
only help you to understand the parameters being monitored, they help you
explain your conclusions to others. This appendix gives some suggestions
you may find helpful when dealing with this data.

The three line summary graph depicts the maximum, average, and minimum
values monitored during the monitoring session, and also the peak-to-peak
value.
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A selection box has been drawn, causing the values on the box to appear in the
status bar. The dark center line is the average of the sampled data.

Minimum, Maximum, and Average

The average values are calculated over a time base which is set by choosing
the selected monitoring period in the Monitor dialog box (shown below).
This averaging period is indicated by the Sample Resolution which changes
for each monitoring period selected.
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In the above example, the average value presented for summatries is the
Cycle-by-Cycle RMS values averaged over a 6 second window. The
maximum (displayed as the upper gray line on the graph) in this same period
is the maximum single cycle RMS value measured every 6-seconds used to
calculate the average. The minimum value (presented as the lower gray line
on the graph) is the minimum individual cycle RMS value measured for all
cycles constituting this same average. Therefore, the user is provided with the
maximum RMS cycle value, minimum RMS cycle value, and average of all
cycles for every 6-second interval during the monitoring period of 6-hours.

Using These Graphs in Other Documents

The summary graphs presented in this document were copied from the
Power Analysis System Software. So that they would print correctly, the
following settings WerLused.

®  From the Option Menu, the Color command was chosen...

.HPM Power Recorder System - [Untitled)

File Edit Recorder anctionﬂelp

SEl e

Freferences.”.

Full Scale Settings. ..
Multipliers. ..
Demand Power...

m ... and Monochrome was selected.
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While Monochrome was selected, the Summary Min/Max lines were
changed to the color yellow. When printed using an HP Laser]Jet, the yellow
lines appear grayed and distinct from the average line as follows.
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Appendix G. Dial-Up Networking
Settings

If you want to use Dial-Up Networking to connect to a Power Recorder on a
remote network under Windows, you should make sure that the settings in
Dial-Up Networking match the ones in your Network Control panel.

To compare Dial-Up Networking Settings against Network
Control Panel settings

1. Open the Dial-Up Networking Folder (Dial-Up Networking must
already be installed.)

In Windows, double-click the My Computer icon to see the folder for
Dial-Up Networking. Then double-click the Dial-Up Networking folder
to open it.
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2. the list of connections, highlight the connection you want to check, click
the right mouse button to display the menu, and choose Properties.
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3. In the dialog box that appears, click the Server Type button.
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4. In the Server Type dialog box, review the settings under “Allowed
Network Protocols”.
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The Allowed Network Protocols are the protocols that must match
settings in the Network Control panel.

5. Open the Network Control Panel.

From the Start menu, choose Settings, Control Panel, and then
Network.

6. In the Control Panel, scroll through the list of installed components until
you see the ones for the Dial-Up Adapter.
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You should see installed components that match the protocols in the
Dial-Up Networking connection. For example, if NetBEUI is marked in
the Dial-Up Networking Server Type dialog box, then you should have
an installed component named “NetBEUL”

If the installed components don’t match the settings in Dial-Up
Network, you probably need to install additional components from the
Windows system disk. For more information, see the topic “Dial-Up
Networking” in the Windows online help.

123



Power Recorder System User Guide

124



Appendices

Appendix H. International Color Codes

Color codes associated with phases, neutral and ground are different
throughout the world. The following table shows color coding for the United
States, Europe, and Great Britain.

Phase

U. S. Color Code

European Color Code

U. K. Color Code

A

B

C
Neutral

Ground

Black
Red
Blue

White

Green

Black
Red
White
Blue

Yellow and Green
Stripe

Red
Yellow
Blue
Black

Yellow and Green
Stripe
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Appendix |. Power Recorder (PR)
Specifications

Measurement Parameters

Voltage

Five (5) Channels:

Channels 1 - 3 ( generally used for phase conductor measurements)
Input: 100 millivolts to 1000 Volts peak (707 volts RMS max.)
Accuracy: T 1% of full scale. (typically 0.5%)

Impulses: 100 volts peak to 6400 Volts peak * 2% of full scale.
Impedance: 2 megohms to ground

Capacitance: < 30 pf

Frequency: 60/50 Hz + 0.1 Hz

Channel 4 (for neutral conductor measurements)
Input: 10 millivolts to 100 Volts peak (70 volts RMS max.)
Accuracy: £ 1% of full scale.
Impulses: 10 volts peak to 640 Volts peak * 2% of full scale.
Impedance: 200 kohms to ground
Capacitance: < 30 pf
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Current
Five (5) Channels

Channels 6 - 10 (for current measurements with current clamp)

Input: Current Clamp Dependent
Standard Configurations: 0.10 - 5.0 Amps RMS
0.10 - 40 Amps RMS
1.00 - 1000 Amps RMS
10.0 - 3000 Amps RMS
CT Accuracy: 5 Amp Clamp - 10mA to 5A: 2%
+*1mA
40 Amp Clamp - 10 mA to 40 A:1.5% £ 2mA
1000 Amp Clamp - 1 A: 10% of Reading

50 A: 0.7% of Reading
200 A: 0.6% of Reading
1000 A: 0.5% of Reading
3000 Amp Clamp 150A:  1.5% of Reading
600A:  0.75% of Reading
3000A:  0.5% of Reading
Accuracy: *0.1% of full scale (plus CT accuracy)

Sampling

Voltage and current wave-forms are sampled with a 14 bit analog to digital converter
at a rate providing 128 sampled points per cycle at 50 and 60 Hz. Impulses are
sampled using a 10 bit analog to digital converter at a software selected rate of 2
million times per second.

Power Requirements

85 - 264 Vrms, 47 - 440 Hz
10 - 15 VDC with optional DC power cable
47 VA Max.

Dimensions

Size: 8.5” x 11”7 x 3.5”
Weight:  13.5 pounds

Environmental Requirements

Operating: 0° C to 50° C
Humidity: Weatherproof
Storage: -20° C to 60° C
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Measurement Characteristics

1. The monitor has 2 minimum of nine simultaneous measurement channels, with a
minimum of five channels to measure current.

2. Voltage measurements are covered in a single range.

3. Voltage and current wave-forms are sampled with a 14 bit analog to digital
converter at a rate providing 128 sampled points per cycle at 50 and 60 Hz.
Impulses are sampled using a 10 bit analog to digital converter at a software
selected rate of 2 million times per second.

4. Harmonic measurements on all channels are to the 63rd harmonic to include
amplitude and phase angle for each harmonic, % of fundamental, and individual
harmonic RMS volts and currents.

5. RMS and harmonic measurements are made continuously on each cycle. The
minimum RMS measurement time is one cycle.

6. The following power measurements are made every cycle: Watts, VA, VAR, true
power factor, and displacement power factor.

7. The Power Recorder SYSTEM provides vector addition and subtraction tools
add or subtract voltage or current wave-forms on an IBM compatible PC.

Calibration

The Power Recorder is a microprocessor based instrument utilizing advanced solid
state IC’s and A/D converters that are inherently stable with respect to repeatability
and time. If your company has a recommended calibration schedule, the Power
Recorder can be checked for accuracy. Should the instrument not meet the accuracy
specifications ( +/- 1% ES for voltage and +/- 0.1% FS plus CT accuracies for
current), the Power Recorder may need to be returned to Reliable Power Meters for
testing and/or repair. Contact RPM Technical Support.

Batteries

The Power Recorder utilizes two batteries on board. The clock oscillator uses a
lithium battery with a life span of ten years. The second battery is a nicad battery
which is used to power the instrument in the event of a power failure. This battery
will power the instrument for five minutes before the instrument will perform an
orderly shutdown and is charged when power is applied to the Power Recorder. If
the battery fails to charge, return the instrument to RPM for repair.
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Resolution Vs Recording Time

The PR has a user selectable recording period. Based on the period selected, the PR
will provide a predetermined resolution of RMS, power, and harmonic data as

follows:

Recording Period Resolution
15 Minutes 15 cycles
30 Minutes 0.5 second
1 hour 1 second
3 hours 3 seconds
6 hours 6 seconds
12 hours 15 seconds
24 hours 30 seconds
48 hours 1 minute
5 days 3 minutes
1 week 5 minutes
2 weeks 10 minutes
1 month 15 minutes
90 days 1 hour
1 year 4 hours

All recordings are performed via the digital signal-processing chip and are done on a
cycle-by-cycle basis. Regardless of the recording period or the resolution, the
minimum and maximum values have a one-cycle response.

If you should have any further questions, please call the factory at (408) 358-5100 for
assistance.
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Appendix J. Theory of Operation

Calculations Utilized by the Power Recorder

Power Recorder Architecture

14 bit, 7.8 kHz (707 Vrms max.,

voltage attenuator T Y el L)
) <4 kHz 1 bsp
2MQ _\_
sample
& hold 386 +
387

- | 4MB cache
impu se> ,
logic "
>4 kHz

10 bit, 4 MHz
(6400 Vpk max., 540 MB
12 V resolution) disk
monitor Optional impulse capture circuit

- ||-c»-|:|——|:|—I

Architecture

1000:1 attenuation allows direct connection to 707 Vrms. Voltage and
current wave-forms are sampled with a 14 bit analog-to-digital converter at
an approximate rate of 8 kHz, phase locked, providing 128 sampled points
per cycle at 50 and 60 Hz. Sampled data is passed to the digital signal
processor (DSP) that performs a Fast Fourier Transform to the 63
harmonic (FFT) in less than 10 HPsec on each cycle of voltage and current.
Impulses are sampled using a 10 bit analog-to-digital converter at a software
selected rate of 4 or 2 million times per second. Internal control is via
386/387 and 4 MB cache memory.

Computations

1. True RMS measurements

The Power Recorder computes the RMS voltage and current over each cycle
(128 data points) as follows:
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where V- and [,

rms

are sampled voltage and current values

S

2. Imbalance

Imbalance of voltage and current are calculated in accordance with the IEEE
definition of the maximum deviation from the avg of the voltages or
currents, divided by the avg of the voltages or currents, expressed in percent.

V

= Maxdev 5 100%, where V
0, where Y

v, =V -V
axdev Avg Dev

Im balance
Avg

3. Total Harmonic Distortion (THD)

Total Harmonic Distortion (THD) is calculated on a cycle-by-cycle basis for
both voltage and current as follows (where Viand A, are the respective
harmonic voltage and current):

63 63

2% 2"

Vi == ——x100% Ly === x100%

1 1

4. Apparent Power (VA)

AC power in Volt-Amps is calculated as follows where Vims Lims are True
RMS values and Vr and Irare the Fundamental RMS value:

True VA= VA, =V, X 1,

True rms

Fundamental VA= VA, =V,.X [,

5. Watts

Watts are calculated from each sampled voltage point times its corresponding
sampled current point, on a cycle-by-cycle basis. This results in true power
calculations including any harmonic distortion:
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128
ZV X I,
W. =
True 128

Fundamental Watts are calculated as shown:

Wr = Ve X Ir Cos (9)

6. Power Factor

True Power Factor is the ratio of true power to apparent power and is
calculated as follows:

PF — WTrue
True — VA

True

Fundamental Power Factor is the angle between fundamental Voltage and
fundamental Current (Displacement Power Factor)

PFr = Cos ()

where 0 is the angle between fundamental Voltage and fundamental Cutrent
(Displacement Power Factor).

7. Reactive Power (VAR)

Fundamental VAR is calculated as the product of the fundamental voltage
times the fundamental frequency times the Sine of the displacement power
factor.

VAR, = VA, Sin@

True VAR is calculated as follows:

2
WT rue

VAR, = VA,

True True

8. Distortion Power D (Watts)

Distortion Power is the non-fundamental power and is calculated as follows:

D = WATTSte - WATTSE
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A

analysis data
copying, 84
in reports, 84
viewing, 82
Analysis tools
displaying, 82
overview, 83
using, 82
analyzing power quality and consumption, 82
ANSIL. See Tolerance Curves

apparent power (VA) , how it is calculated, 132

arming the Power Recorder, 41, 52, 64
Average lines, hiding, 86

B

batteries in Power Recorder, 129
battery-type voltage probe, 50

C

calculations and measurements, 131
Capture button, 81
CBEMA. See Tolerance Curves
checking
connections, 54
connections with the Phasors tool, 95
polarity of current clamps, 95
status of monitoring, 65
voltage interface cable LEDs, 55
clamps and probes, installing, 53
closing a window, 13
color coded leads, 53
color codes
color coded leads, 48
International, 125
on the Power Recorder panel, 48, 50, 53
color settings
changing, 86

customizing, 86
returning to original, 87

communication controller

setting up a Dial-Up Server, 29

compressing a database, 19

configuration

Power Recorder
changing, 40, 41
definition, 99
editing, 40, 41
in the Link dialog box, 39
system, 4

configuring the Power Recorder, 26-43
connecting a Power Recorder to wiring, 53
Connecting to a Power Recorder, 27

using a dial-up connection, 29
using a direct connection from a PC, 28
using a network connection, 27

connections

checking, 54, 55
double-checking, 58
verifying with the Phasors tool, 91-96

conventions in this manual, ix
Copy Graphics command, 84
Copy Status Text command, 85
Copy to Text File command, 84, 86

copying

black and white version of a graph, 84
data into a text file, 86
status text, 85

creating

database, 18
new location, 24
new site, 22

crocodile-type voltage probe, 49
current

rotating, 94
swapping, 95

current clamps

attaching to the cutrent interface cable, 48
attaching to the Power Recorder, 48
checking the polarity of, 95
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selecting and attaching, 46
table of clamps, 46
current clamps and voltage probes
pairing, 53, 54, 58
current interface cable
attaching to current clamps, 48
LEDs, flashing on and off, 52
Current Rotate tools, 93, 94
Current Swap tools, 93, 95
Customer Support, iv

D
data, saving or discarding, 72
database
compressing a copy, 19
creating, 18
definition, 99
deleting, 21

expanding a compressed copy, 20
opening, 17
opening a new one (preferences), 18, 89
opening the last used (preferences), 89
repairing, 20
saving a copy, 18
database, Power Recorder System Software, 17-21
deleting a database, 21
demand power interval, setting, 91
Dial-Up Connection to a Power Recorder, 29
Dial-Up Networking settings, 121
Dial-Up Server
dialing in to access a Power Recorder, 31

setting up a Dial-Up Setver to be a
communication controller, 29

directory of sites, 22
disconnecting
PC and parallel Power Recorder, 74
Power Recorder from the Wiring, 75
disk space in Power Recorder, 2
disk space required
for a database file, 66
for the software, 9
distortion power (Watts), how it is calculated, 133
Distortion tool, 83
distortion, viewing, 82
Disturbance tool, 83
disturbances, viewing, 82
Download dialog box, 68

downloading data, 65-70
events, 67,70
individual events, 70
selected events, 68
several approaches, 66
some or all data, 67
summaries, 67
while checking the status of monitoring, 68

E
edit configuration settings, 40, 41
Ethernet Settings in the Network Control Panel, 27
Event History graph, 83, 109
event links, whether to display (preference), 89
Event Tolerance graph, 83, 109
event types, 116
events
downloading, 67, 70

graphs of, plotted by tolerance and history, 83,
109

locating ones at specific dates & times, 113
moving from one event to another, 112
not downloaded, 113
sample Impulse graphic, 110
sample of steady state event, 110
sample transition event, 109
saving data from graphs as text, 86, 115
that appear as Xs on a graph, 112
types of graphs, 109
viewing, 82

expanding a compressed database, 20

F

feed phase, set for a single-phase location, 24
frequency
set as a preference, 88
full scale settings, changing, 90
fundamental VAR, how it is calculated, 133

G
getting help, 15
graphs
changing colors of, 86
gray border, displaying around graphs, 87
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H

Harmonics tool, 80
harmonics, viewing, 78
help
about a view or window, 15
getting, 15
using, 15
History graph, 109. Se¢ Event History graph

using to check for events at specific dates and
times, 113

1
icons
defined, 12
opening, 12, 13
icons and windows, using, 12
imbalance for voltage or current, on Distortion
graphs, 83
imbalance, how it is calculated, 132
impedance
negative, 95
viewing, 78
Impedance tool, 80
Impulse Graphic, sample, 110
in-line fuse holder, 50
installing
clamps and probes, 53
Power Recorder System Software, 7
the Power Recorder, 43-59
International color codes, 125
Invert tool, 96
ITIC. See Tolerance Curves

L
language used onscreen, set as a preference, 88
leads, color coded, 48, 53
LEDs
checking on voltage interface cable, 55
current interface cable, 54
flashing on and off, 52
Power Recorder connection panel, 54, 55
voltage interface cable, 58
Link Info command, 40
linking the Power Recorder and the PC, 36
location information, 22
locations

capturing scope settings for, 81
creating, 24
definition, 99
multiple for one site, 24, 72
locking Power Recorder in place, 59
long-term summaty data
inspecting, 2
long-term summary graphs of voltage, current, and
frequency, 83

M
magnify
tool, 14
waveform data, 14
measurement characteristics of Power Recorder, 129

measurement options, adding to a Power Recorder,
107
Min/Max lines
changing color of, 119
Min/Max lines, hiding, 86
minimum, maximum, and average on summary
graphs, 117
minimum, maximum, and average, how they're
calculated, 118
Monitor dialog box, 42, 62
Monitor Period, set as a preference, 89
monitoring
arming the Power Recorder, 64
changing the settings, 64
checking the status, 65
control options
Monitor After Power Applied, 42, 64
Monitor at, 42, 64
Monitor Now, 42, 62
for how long, 42
period, 63, 64
period, set as a preference, 89
resuming after pausing, 63
setting when it will take place, 41
starting now, 62
stopping or pausing, 63
monitoring data, 59—65
monochrome, displaying graphs in, 84, 86, 87
multiple locations for one site, 24
multipliers, changing, 89
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N
negative impedance, 95
NetBEUI, 27, 123
network connection
Power Recorder and PC, 27
Network Control Panel settings
for Dial-Up Networking, 121
for Ethernet, 27

nominal voltage, set as a preference, 88

(0]

opening
anicon, 12, 13
another window, 14
database, 17
sample database, 11
windows, 13

oscilloscope tools, 1

P

pairing current clamps and voltage probes, 53, 54, 58
panel, color coded, 48
pausing monitoring, 63
and resuming, 63
PC System Requirements, 5
PF, VAR, VA, and watts, 84
phase connectors
connecting voltage probes to, 54
Phase Rotate tools, 93, 94
phase rotation, 94
changing, 93
checking, 92
Phase Swap tools, 93, 94
phase swapping, 94
Phasors tool, 79
using to check connections, 91-96
phasors, viewing, 78
plunger type voltage probe, 50
polarity
checking, 95
reversed, 95
reversing, 96
polarity of current clamps, 95
incorrect, 92
Power Analysis tool, 84
power analysis, viewing, 82

power factor, how it is calculated, 133
Power Recorder
architecture, 131
arming, 41, 52
batteries, 129
calculations and measurements, 131
configuring, 26—43
connecting directly to a PC, 28
connecting to power source, 51
connecting to wiring, 53
definition, 99
disconnecting from PC (parallel or Ethernet), 74
disconnecting from the wiring, 75
installing, 43—59
measurement characteristics of, 129
putting in place, 51
resetting, 62
specifications, 127
theory of operation, 131
unlinking from PC, 72
updating the Power Recorder System Software
in, 104
upgrading with additional measurement options,
107
Power Recorder configuration
changing, 41
definition, 99
editing, 40, 41
in the Link dialog box, 39
Power Recorder System
definition, 99
what's included, 4
Power Recorder System Help, ix, 15
Power Recorder System overview, 10-3
Power Recorder System Software
basics, 9
database, 17-21
overview of tools, 75-96
shutting down, 74
power type for a location, 24
power type, set as a preference, 88
Power Vectors tool, 80
preferences, 87—89
database to open, 18
display event links, 89
frequency, 88
language, 88
monitoring period, 89
nominal voltage, 88
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power type, 88
tolerance format, 88
Use Last Database, 89
probes and clamps
connecting to wiring, 53

R
range lights

checking, 54
reactive power (VAR) , how it is calculated, 133
real-time conditions, inspecting, 1, 78
reference materials, 101
repairing a database, 20
reports

using scope and analysis data in, 84—86
resetting the Power Recorder, 40, 62
resuming monitoring after pausing, 63
reversing polarity, 95, 96
rotating phases, 94
rotating the current, 94

S

safety features, 3
safety tips
pairing probes and clamps, 54
tagging, labeling, posting signs, 59
when grounding, 45
when making connections, iii, 53
Sample Database
keeping or overwriting when updating software,
103
opening, 11
saving a copy of a database, 18
saving or discarding data, 72
scope data
capturing scope settings, 81
copying, 84
in reports, 84
viewing, 78
scope sweep, 80
pausing and restarting, 80
scope tools, 78
displaying, 78
overview, 79
using, 78
selecting
current clamps to use, 46

events, and downloading them, 68
voltage probes to use, 49
setting up a new site, 22
shutting down the Power Recorder System Software,
74
side-clamp voltage probe, 49
site directory, 22, 41
location, definition, 99
setting up sites and locations, 22
site, definition, 99
sites and locations, 22
snapshot of waveforms, 1
Specifications, 127
starting the Power Recorder System Software, 9
status of monitoring, checking, 65
steady state event, sample of, 110
stopping monitoring, 63
summary graphs, 117
minimum, maximum, and average, 117
swapping current, 95
swapping phases, 94
syringe stud-type voltage probe, 49
system configuration, 4
System Requirements, 5

T
TCP/IP
assigning a TCP/IP address to a Power
Recorder, 33
associating TCP/IP address with Power
Recorder serial number, 34
setting up a TCP/IP connection, 33
Trouble-Shooting Tip, 35
technical support, iv
text file, copying data into, 86
threaded stud-type voltage probe, 49
Tolerance curves, 111
set as a preference, 88
set for a location, 24
Tolerance graph, 109. See Event Tolerance graph
tools
in a window, 13
magnify tool, 14
overview, 75-96
total harmonic distortion (THD) , how it is
calculated, 132
transition event, sample, 109
True RMS measurements, 131
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U
unlinking the Power Recorder and the PC, 72
updating the Power Recorder System Software, 103
in the PC, 104
in the Power Recorder, 104

4
VAR, VA, PF, and watts, 84
VIF summaries tool, 83
VIF summaries, viewing, 82
voltage interface cable
attaching to voltage probes, 50
LEDs, flashing on and off, 52
voltage interface cable LEDs, 58
voltage probes
attaching to leads on the voltage interface cable,
50
attaching to the Power Recorder, 50
battery-type, 50
connecting to phase connectors, 54
crocodile-type, 49
in-line fuse holder, 50
plunger type, 50
selecting and attaching, 49
side-clamp, 49
syringe stud-type, 49
threaded stud-type, 49

voltage probes and current clamps, pairing correctly,
53, 54, 58

/4
watts, how calculated, 132
Watts, VAR, VA, and PF, 84
waveforms, 79
capturing snapshot of, 81
snapshot of, 1
viewing, 78
Waveforms tool, 79

window tools, 13

windows
closing, 13
opening, 13

opening more than one, 14
seeing more detail, 14
wiring
connecting a Power Recorder to, 53
wiring, disconnecting the Power Recorder from, 75

Z

zoom
see magnify, 14
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